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SPECIAL MESSAGE SECTION

PRODUCT SAFETY MARKINGS: Yamaha electronic
products may have either labels similar to the graphics
shown below or molded/stamped facsimiles of these graph-
ics on the enclosure. The explanation of these graphics
appears on this page. Please observe all cautions indicated
on this page and those indicated in the safety instruction sec-
tion.

6 RISK OF ELECTRIC SHOCK l
DO NOT OPEN .

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK.
DO NOT REMOVE COVER (OR BACK).
NO USER-SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The exclamation point within the equi-
lateral triangle is intended to alert the
user to the presence of important operat-
ing and maintenance (servicing) instruc-
tions in the literature accompanying the
product.

The lightning flash with arrowhead sym-

bol, within the equilateral triangle, is

intended to alert the user to the presence

of uninsulated “dangerous voltage”

within the product’s enclosure that may

be of sufficient magnitude to constitute a
risk of electrical shock.

IMPORTANT NOTICE: All Yamaha electronic products
are tested and approved by an independent safety testing
laboratory in order that you may be sure that when it is prop-
erly installed and used in its normal and customary manner,
all foreseeable risks have been eliminated. DO NOT modify
this unit or commission others to do so unless specifically
authorized by Yamaha. Product performance and/or safety
standards may be diminished. Claims filed under the
expressed warranty may be denied if the unit is/has been
modified. Implied warranties may also be affected.

SPECIFICATIONS SUBJECT TO CHANGE: The infor-
mation contained in this manual is believed to be correct at
the time of printing. However, Yamaha reserves the right to
change or modify any of the specifications without notice or
obligation to update existing units.

92-469- (1) (rear)
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ENVIRONMENTAL ISSUES: Yamaha strives to produce
products that are both user safe and environmentally
friendly. We sincerely believe that our products and the pro-
duction methods used to produce them, meet these goals. In
keeping with both the letter and the spirit of the law, we
want you to be aware of the following:

Battery Notice: This product MAY contain a small non-
rechargeable battery which (if applicable) is soldered in
place. The average life span of this type of battery is approx-
imately five years. When replacement becomes necessary,
contact a qualified service representative to perform the
replacement.

Warning: Do not attempt to recharge, disassemble, or
incinerate this type of battery. Keep all batteries away from
children. Dispose of used batteries promptly and as regu-
lated by applicable laws. Note: In some areas, the servicer is
required by law to return the defective parts. However, you
do have the option of having the servicer dispose of these
parts for you.

Disposal Notice: Should this product become damaged
beyond repair, or for some reason its useful life is consid-
ered to be at an end, please observe all local, state, and fed-
eral regulations that relate to the disposal of products that
contain lead, batteries, plastics, etc.

NOTICE: Service charges incurred due to lack of knowl-
edge relating to how a function or effect works (when the
unit is operating as designed) are not covered by the manu-
facturer’s warranty, and are therefore the owners responsi-
bility. Please study this manual carefully and consult your
dealer before requesting service.

NAME PLATE LOCATION: The graphic below indicates
the location of the name plate. The model number, serial
number, power requirements, etc., are located on this plate.
You should record the model number, serial number, and the
date of purchase in the spaces provided below and retain this
manual as a permanent record of your purchase.

Model

Serial No.

Purchase Date



RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK.
DO NOT REMOVE COVER (OR BACK).
NO USER-SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The above warning is located on the rear of the unit.

Explanation of Graphical Symbols

The lightning flash with arrowhead symbol
within an equilateral triangle is intended to alert
the user to the presence of uninsulated
“dangerous voltage” within the product’s
enclosure that may be of sufficient magnitude to
constitute a risk of electric shock to persons.

The exclamation point within an equilateral
triangle is intended to alert the user to the
presence of important operating and
maintenance (servicing) instructions in the
literature accompanying the product.

IMPORTANT SAFETY INSTRUCTIONS

NOoO O WN-

10

Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this apparatus near water.

Clean only with dry cloth.

Do not block any ventilation openings. Install in
accordance with the manufacturer’s instructions.

Do not install near any heat sources such as radiators,
heat registers, stoves, or other apparatus (including
amplifiers) that produce heat.

Do not defeat the safety purpose of the polarized or
grounding-type plug. A polarized plug has two blades
with one wider than the other. A grounding type plug
has two blades and a third grounding prong. The wide
blade or the third prong are provided for your safety. If
the provided plug does not fit into your outlet, consult
an electrician for replacement of the obsolete outlet.
Protect the power cord from being walked on or pinched
particularly at plugs, convenience receptacles, and the
point where they exit from the apparatus.

13

14

Only use attachments/accessories specified by the
manufacturer.

Use only with the cart, stand,
tripod, bracket, or table specified
by the manufacturer, or sold with
the apparatus. When a cart is ()
used, use caution when moving
the cart/apparatus combination
to avoid injury from tip-over. ". 3
Unplug this apparatus during

lightning storms or when unused for long periods of
time.

Refer all servicing to qualified service personnel.
Servicing is required when the apparatus has been
damaged in any way, such as power-supply cord or plug
is damaged, liquid has been spilled or objects have
fallen into the apparatus, the apparatus has been
exposed to rain or moisture, does not operate normally,
or has been dropped.

WARNING

TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THIS APPARATUS TO RAIN OR MOISTURE.

(ULB0065_03)

Information for Users on Collection and Disposal of Old Equipment

This symbol on the products, packaging, and/or accompanying documents means that used electrical and electronic
products should not be mixed with general household waste.
For proper treatment, recovery and recycling of old products, please take them to applicable collection points, in
accordance with your national legislation and the Directives 2002/96/EC.

By disposing of these products correctly, you will help to save valuable resources and prevent any potential negative
effects on human health and the environment which could otherwise arise from inappropriate waste handling.

For more information about collection and recycling of old products, please contact your local municipality, your waste

disposal service or the point of sale where you purchased the items.

[For business users in the European Union]
If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for further information.

[Information on Disposal in other Countries outside the European Union]
This symbol is only valid in the European Union. If you wish to discard these items, please contact your local authorities or dealer and
ask for the correct method of disposal.
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PRECAUTIONS

PLEASE READ CAREFULLY BEFORE PROCEEDING
* Please keep this manual in a safe place for future reference.

A WARNING

Always follow the basic precautions listed below to avoid the possibility of serious injury or even death from electrical
shock, short-circuiting, damages, fire or other hazards. These precautions include, but are not limited to, the following:

Power supply/Power cord

o Only use the voltage specified as correct for the instrument. The required voltage
is printed on the name plate of the instrument.

Check the electric plug periodically and remove any dirt or dust which may have
accumulated on it.

Use only the supplied power cord/plug.

Do not place the power cord near heat sources such as heaters or radiators, and
do not excessively bend or otherwise damage the cord, place heavy objects on
it, or place it in a position where anyone could walk on, trip over, or roll anything
over it.

Be sure to connect to an appropriate outlet with a protective grounding
connection. Improper grounding can result in electrical shock.

e Do not open the instrument or attempt to disassemble the internal parts or
modify them in any way. The instrument contains no user-serviceable parts. If it
should appear to be malfunctioning, discontinue use immediately and have it
inspected by qualified Yamaha service personnel.

/\ cauTioNn

* Do not expose the instrument to rain, use it near water or in damp or wet
conditions, or place containers on it containing liquids which might spill into
any openings. If any liquid such as water seeps into the instrument, turn off the
power immediately and unplug the power cord from the AC outlet. Then have the
instrument inspected by qualified Yamaha service personnel.

e Never insert or remove an electric plug with wet hands.

e Do not put burning items, such as candles, on the unit.
A burning item may fall over and cause a fire.

If you notice any ahnormality

e |fthe power cord or plug becomes frayed or damaged, or if there is a sudden
loss of sound during use of the instrument, or if any unusual smells or smoke
should appear to be caused by it, immediately turn off the power switch,
disconnect the electric plug from the outlet, and have the instrument inspected
by qualified Yamaha service personnel.

Always follow the basic precautions listed below to avoid the possibility of physical injury to you or others, or damage
to the instrument or other property. These precautions include, but are not limited to, the following:

Power supply/Power cord

o Always connect the three-pin attachment plug to a properly grounded power
source. (For more information about the main power supply, see page 16.)

o When removing the electric plug from the instrument or an outlet, always hold
the plug itself and not the cord. Pulling by the cord can damage it.

e Remove the electric plug from the outlet when the instrument is not to be used
for extended periods of time, or during electrical storms.

e Do not connect the instrument to an electrical outlet using a multiple-connector.
Doing so can result in lower sound quality, or possibly cause overheating in the
outlet.

e Do not expose the instrument to excessive dust or vibrations, or extreme cold or
heat (such as in direct sunlight, near a heater, or in a car during the day) to
prevent the possibility of panel disfiguration or damage to the internal
components.

® Do not use the instrument in the vicinity of a TV, radio, stereo equipment, mobile
phone, or other electric devices. Otherwisg, the instrument, TV, or radio may
generate noise.

* Do not place the instrument in an unstable position where it might accidentally
fall over.

® Before moving the instrument, remove all connected cables.

o When setting up the product, make sure that the AC outlet you are using is
gasily accessible. If some trouble or malfunction occurs, immediately turn off
the power switch and disconnect the plug from the outlet. Even when the power
switch is turned off, electricity is still flowing to the product at the minimum
level. When you are not using the product for a long time, make sure to unplug
the power cord from the wall AC outlet.

(1)-12 1/2
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Before connecting the instrument to other electronic components, turn off the
power for all components. Before turning the power on or off for all components,
set all volume levels to minimum. Also, be sure to set the volumes of all
components at their minimum levels and gradually raise the volume controls
while playing the instrument to set the desired listening level.

e When cleaning the instrument, use a soft, dry cloth. Do not use paint thinners,
solvents, cleaning fluids, or chemical-impregnated wiping cloths.

Handling caution

o Never insert or drop paper, metallic, or other objects into the gaps on the panel
or keyboard. If this happens, turn off the power immediately and unplug the
power cord from the AC outlet. Then have the instrument inspected by qualified
Yamaha service personnel.

Do not place vinyl, plastic or rubber objects on the instrument, since this might
discolor the panel or keyboard.

Do not rest your weight on, or place heavy objects on the instrument, and do not
use excessive force on the buttons, switches or connectors.

Do not use the instrument/device or headphones for a long period of time at a
high or uncomfortable volume level, since this can cause permanent hearing
loss. If you experience any hearing loss or ringing in the ears, consult a
physician.

Saving data

Saving and backing up your data

DRAM data (refer to the Reference Manual <separate PDF documentation>) is
lost when you turn off the power to the instrument. Save the data to the flash
ROM/the internal flash memory (see page 47)/a USB storage device/external
device such as a computer.

Data stored to the flash ROM may be lost due to malfunction or incorrect
operation. Save important data to a USB storage device/external device such as
acomputer.

Never attempt to turn off the power while data is being written to Flash ROM
(while an “Executing...” or “Please keep power on” message is shown). Turning
the power off in this state results in loss of all user data and may cause the
system to freeze (due to corruption of data in the Flash ROM). This means that
this synthesizer may not be able to start up properly, even when turning the
power on next time.

Backing up the USB storage device/external media

To protect against data loss through media damage, we recommend that you
save your important data onto two USB storage devices/external media.

Yamaha cannot be held responsible for damage caused by improper use or modifications to the instrument, or data that is lost or destroyed.

Always turn the power off when the instrument is not in use.

(1)-12 2/2
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Welcome

A message from the S90 XS/S70 XS Development Team

Thank you for purchasing the Yamaha S90 XS/S70 XS Music Synthesizer.

We're extremely proud to introduce the new S90 XS/S70 XS as the successor to the original S90 ES. Equipped with
exceptionally high-quality musical instrument sounds and a real piano-feel response, this is truly the instrument of choice
for musicians and players worldwide, whatever the genre. Drawing on our long experience cultivated through years of
synthesizer development, we designed this model not only for top professional musicians, but also for casual players
and hobby musicians who want to have a greater level of high-quality sound, playability and advanced features—
especially in live performance applications. To complete this lineup, we've added the S70 XS, a 76-key model which
maintains the same keyboard touch as the 88-key model, yet provides the added value of portability.

The advanced and convenient features of the S90 XS/S70 XS do not stop there. The Remote Control functions and the
Master Keyboard features have been enhanced and made more powerful to meet the demands of professional music
production. We are proud and confident that the S90 XS/S70 XS can aid in your music making, and we're sure that it will
be your first ‘go-to’ instrument in music situation, live performance, recording and so on.

In order to take full advantage of the S90 XS/S70 XS’s functionality, please read this manual carefully. We also
recommend that you keep this manual in a safe and handy place for future reference.

We really hope that the S90 XS/S70 XS will help your creativity and musical work grow by leaps and bounds.

Enjoy!

Accessories

e AC Power cord
e Owner's Manual (this book)

Sincerely,

The Yamaha S90 XS/S70 XS Development Team

e Owner’s Manuals CD-ROM x 1 (Reference Manual, Data List)

¢ Disk x 1 (containing DAW software)

About the accessory disk
Special Notice

e The software included in the accessory disk and the
copyrights thereof are under exclusive ownership by
Steinberg Media Technologies GmbH.

® Use of the software and this manual is governed by the
license agreement which the purchaser fully agrees to upon
breaking the seal of the software packaging. (Please read
carefully the Software Licensing Agreement before installing
the application.)

e Copying of the software or reproduction of this manual in
whole or in part by any means is expressly forbidden without
the written consent of the manufacturer.

e Yamaha makes no representations or warranties with regard to
the use of the software and documentation and cannot be
held responsible for the results of the use of this manual and
the software.

e This disk is NOT for audio/visual purposes. Do not attempt to
play the disk on an audio/visual CD/DVD player. Doing so may
result in irreparable damage to your player.

¢ Note that Yamaha does not offer technical support for the
DAW software in the accessory disk.
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About the DAW software in the
accessory disk

The accessory disk contains DAW software both for Windows
and Macintosh.
NOTE

* Make sure to install DAW software under the “Administrator” account.

e |n order to have continuous use of Cubase Al 4, including support and
other benefits, you will need to register the software and activate your
software license by starting it while the computer is connected to the
Internet. Click the “Register Now” button shown when the software is
started, then fill in all required fields for registration. If you do not
register the product, you will be unable to use the application after a
limited period of time expires.

e |f you are using a Macintosh computer, double-click the “***.pkg” file to
start installation.

For information about the minimum system requirements and

latest information on the software in the disk, check the web site

below.

http://www.yamahasynth.com/download/

About software support

Support for the DAW software in the accessory disk is provided
by Steinberg on its website at the following address.
http://www.steinberg.net

You can visit the Steinberg site also via the Help menu of the
included DAW software. (The Help menu also includes the PDF
manual and other information on the software.)



S90 XS/S70 XS Main Features

Huge amount of waveforms and vast sound selection, including top-quality piano sounds
The S90 XS/S70 XS features a whopping 142 MB of exceptionally high-quality piano waveforms, including many
newly sampled sounds, and a vast variety of Voices directly derived from the flagship MOTIF XS Music Production
Synthesizer-giving you a total of 456 MB of available waveforms.

Balanced Hammer Keyboard—with both 88 and 76 keys—provides natural touch and
response

The S90 XS/S70 XS features a sophisticated Balanced Hammer Keyboard (with Initial Touch/Aftertouch) which utilizes
Yamaha'’s long-standing know-how cultivated in its acoustic piano and synthesizer development. The 88-key model
gives you full-scale piano performance, while the smaller 76-key model offers greater portability and ease in
transporting.

Performance Creator

The S90 XS/S70 XS features a Performance Creator function which provides quick and easy Layer/Split /Drum Assign
assignments of your original Performances based on your favorite Voices. You can utilize the current effects and
settings of the Voices, allowing you to come up with your own original Voices very quickly.

Intuitive Panel Composition

The buttons, Knobs and Sliders are well designed and logically placed for optimum, intuitive operation, especially in
live performance. For example, you can quickly select a Part, use the Part switch to turn it on/off, set the Arpeggio
switch on/off, switch Arpeggio Hold on/off—all with the top panel controls—and edit important parameters via the
Knobs and Sliders. A convenient Panel Lock function, which prevents unintended changes during performance, and
a Tap Tempo function for the Arpeggio are also available on the top panel.

Audio Rec/Play Function

You can record your performance to a USB storage device or internal flash memory as a wave file, or you can play
back audio files which have been created on DAW software. You can also play the keyboard along with audio file
playback via the Audio Rec/Play function.

DAW Remote Function

The S90 XS/S70 XS features a DAW Remote function for music production convenience. This allows you to store 50
different control templates and have easy, intuitive control over your main DAW software and VST instruments directly
from the panel controls of the S90 XS/S70 XS.

Voice Editor and Remote Editor for Detailed Editing

When using Cubase series software compatible with VST3 technology, the S90 XS/S70 XS Editor VST can be
conveniently used in the same manner as software VST instruments for editing the detailed parameters. When using
in stand-alone mode, the S90 XS/S70 XS Editor for Studio Manager V2 is also available to edit the detailed
parameters. For setting of the Remote Control function and the Remote Template, the S90 XS/S70 XS Remote Editor
allows you to manage them. You can download them on our web site.

http://www.yamahasynth.com/download/

S90 XS/S70 XS Owner’s Manual




About this Manual

Owner’s Manual (this book)
Explains operations of the top panel controls.

PDF documentation (includes the Owner’s Manual CD-ROM)

B Reference Manual
Explains in detail about the sound-related parameters and effect parameters.

B Data List
This contains various important lists such as the Voice List, Wave List, Multi List, MIDI Implementation Chart,
Performance List, Master Program List, Mixing Template List, Arpeggio Type List and Remote Control Function List.

How to use the PDF manuals

The Reference Manual and the Data List are provided as data documents in PDF format. These PDF files can be
viewed and read on a computer. When using Adobe® Reader® to view a PDF file, you can search for specific
words, print a specific page or link to open a desired section in the manual. The term search and link functions are
especially convenient methods of navigating through a PDF file, and we recommend that you use them.

The latest version of Adobe Reader can be downloaded from the following URL.
http://www.adobe.com/products/reader/

Special Notice

e The contents of this Owner’s Manual and the copyrights thereof are under exclusive ownership by Yamaha Corporation.

e The illustrations and LCD screens as shown in this Owner’s Manual are for instructional purposes only, and may appear somewhat
different from those on your instrument.

® This product incorporates and bundles computer programs and contents in which Yamaha owns copyrights or with respect to which
it has license to use others’ copyrights.

Such copyrighted materials include, without limitation, all computer software, style files, MIDI files, WAVE data, musical scores and
sound recordings. Any unauthorized use of such programs and contents outside of personal use is not permitted under relevant laws.
Any violation of copyright has legal consequences. DON'T MAKE, DISTRIBUTE OR USE ILLEGAL COPIES.

e This device is capable of using various types/formats of music data by optimizing them beforehand to the proper format music data
for use with the device. As a result, this device may not play them back precisely as their producers or composers originally intended.
Copying of the commercially available musical data including but not limited to MIDI data and/or audio data is strictly prohibited
except for your personal use.

e Such copyrighted materials include, without limitation, all computer software, style files, MIDI files, WAVE data, musical scores and
sound recordings. Any unauthorized use of such programs and contents outside of personal use is not permitted under relevant laws.
Consult a legal advisor before using such data.

 Windows is the registered trademark of Microsoft® Corporation.

¢ Apple and Macintosh are trademarks of Apple Inc., registered in the U.S. and other countries.

e Steinberg and Cubase are the registered trademarks of Steinberg Media Technologies GmbH.

e The company names and product names in this Owner’s Manual are the trademarks or registered trademarks of their respective
companies.

e All other trademarks are the property of their respective holders.
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Top panel

Controls and Functions
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© Keyboard

The S90 XS features a 88-key keyboard, while the S70 XS has 76
keys. All are equipped with a touch response feature (both initial
touch and after touch). With initial touch, the instrument senses
how strongly or softly you play the keys, and uses that playing
strength to affect the sound in various ways, depending on the
selected Voice. With after touch, the instrument senses how
much pressure you apply to the keys while playing, and uses
that pressure to affect the sound in various ways, depending on
the selected Voice.

NOTE The keyboard range of the S90 XS is A -1to C7; the range of the
S70 XS is EO to G6.

© Pitch Bend wheel
Controls the pitch bend effect. You can also assign other
functions to this controller.

© Modulation wheel
Controls the modulation effect. You can also assign other
functions to this controller.

O MASTER VOLUME slider

Adjusts the volume of the overall sound. Move the slider
upwards to raise the output level from the OUTPUT L/R jacks
and the PHONES jack.

© [MIC ON/OFF] button
Press the [MIC ON/OFF] button to switch the on/off status of the
MIC INPUT jack.

m S90 XS/S70 XS Owner’s Manual

O INPUT GAIN knob

Use this to adjust the input gain of the audio signals at the MIC
INPUT jack. Depending on the connected microphone, you may
need to adjust this for optimum level. The volume level is
increased as the knob is rotated to the right and decreased as it
is rotated to the left.

© PEAK indicator

This indicator lights up when the input signal level is 3dB below
clipping. Adjust the INPUT GAIN so that the indicator rarely
lights up at signal peak.

© Performance Control buttons

These buttons let you control the functions that affect
Performances and Multis. You can select the part to be
controlled by the knobs and set the Arpeggio-related
parameters for each Part. In the Multi mode, the four parts to be
edited will correspondto1-4,5-8,9-120r 13- 16
(depending on the currently selected Part).

[COMMON] button

In the Performance mode, pressing this button lets you use
the knobs to control the Common parameters.

In the Performance Edit mode, pressing this button will call
up the Common Edit Select display.

[PART SELECT] 1 - 4 buttons

In the Performance mode and Multi mode, pressing one of
these buttons will select the Part to be controlled by the
knob.

In the Voice Edit mode, pressing one of these buttons will
select the Element to be edited via the Quick Edit function.




Controls and Functions
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[PART ON/OFF] 1 — 4 buttons
These buttons turn each Part on and off. In the Voice mode,
only Part 1 is available and is always turned on.

[ARP ON/OFF] button
Turns the “Arp Switch” (a common parameter) on/off. When
this button is turned on, the Arpeggio function is available.

[PART ARP] 1 — 4 buttons

Turn Arpeggio playback on or off for each Part in the
Performance/Multi Mode.

In the Voice mode, pressing either of the [ARP ON/OFF] and
[PART ARP] 1 buttons will turn the Arpeggio playback on or
off for Part 1, since only Part 1 is available.

[HOLD] 1 — 4 buttons

When some of these buttons are turned on, the Arpeggio
playback of the corresponding Parts cycles automatically
even if you release your fingers from the keys, and continues
to cycle until the next key is pressed. In other words, these
buttons turn the “Arp Hold” (a part parameter) on or off. In
the Voice mode, only Part 1 is available.

© Slider Function button

Pressing this button changes the functions assigned to the four
Sliders. The lamp next to the currently active parameters will
light.

In the Voice Edit mode, pressing this button a few times will turn
all the lamps off, indicating that the Sliders can be used to
control the Element levels of the currently edited Voice.

@ Sliders

These control the parameter selected via the Slider Function
button.

In the Voice mode, only the leftmost Slider is available.

In the Performance mode and Multi mode, these Sliders control
the parameter of the corresponding Parts.

In the Master mode, when “Zone Switch” and “Knob Slider Zone
Switch” are on, the Sliders will control the MIDI Control Change
message that is specified for each zone. Otherwise, the function
is the same as that in the Voice/Performance/Multi mode.

NOTE |If all of the Sliders are set to the minimum, you may not hear any
sound from the instrument, even when playing the keyboard. If
this is the case, raise all the Sliders to a suitable level.

The MASTER VOLUME slider adjusts the audio output level from
this instrument. On the other hand, these Sliders adjust the
volume for the Part of the Performance/Multi as a parameter.
Accordingly, the values set via the Sliders can be stored as the
Voice, Performance, Song, or Pattern data.

NOTE
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Controls and Functions
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® Knob Function buttons

Pressing these buttons change the functions assigned to the
four Knobs. The lamp next to the currently active parameters will
light. In the Voice mode, the function of each Knob is applied to
the current Voice; in the Performance/Multi mode, the function of
each Knob is applied only to the currently selected Part (or to all
Parts depending on the setting).

NOTE Controlling the Knobs of the “EFFECT” function will always affect

the sound of all Parts. Controlling the Knobs of the “MIC”
function will work independently.

@ Knobs

These four highly versatile Knobs let you adjust various aspects
or parameters of the current Voice. Use the Knob Function
buttons to change the parameter set for the Knobs.

® Arpeggio/Effect Function button

Pressing this button changes the functions assigned to the five
Function buttons. You can select one of two different functions:
selecting the Arpeggio from 1 -5 and turning each effect on/off.

@ [DAW REMOTE] button

The Remote mode lets you control sequencer software on your
computer from the panel controls of the instrument. Turn the
[DAW REMOTE] button on to enter the Remote mode.

® Function buttons

In the Remote mode, “Top,” “Repeat On/Off,” “Stop,” “Play” and
“Record” are assigned to each of these buttons.

In other modes, the functions specified via the Arpeggio/Effect
Function button are assigned to these buttons.

(® ASSIGNABLE FUNCTION [1]/[2] buttons
You can call up a specific Element of the selected Voice by
pressing each of these buttons during your keyboard
performance. In addition, you can assign other functions to
these buttons.

@ OCTAVE [-)/[+] buttons

Use these buttons to change the note range of the keyboard. To
restore the normal octave setting, press both buttons
simultaneously.
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® TRANSPOSE [-J/[+] buttons

Use these buttons to raise or lower the pitch of the note by one
semitone. To restore the normal octave setting, press both
buttons simultaneously.

® LCD (Liquid Crystal Display)
The backlit LCD displays the parameters and values related to
the currently selected operation or mode.

21
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@ [SHIFT] button

Pressing this button along with another button enables you to
execute various commands. The main functions are as follows.

[SHIFT] + Functions
START/STOP CLICK ON/OFF
AUDIO REC/PLAY Move to Rec Standby display in the Audio Rec/
Play mode
VOICE Bulk dump the edited Voice

PERFORM Bulk dump the edited Performance

MULTI/SEQ PLAY Bulk dump the edited Multi

ENTER Tap tempo for the Arpeggio

INC/DEC, Data dial Change the program number +10.
Change the selected parameter +10 on Edit

display

Cursor [«€]/[»] Select the display mode in the LCD

Knobs 1 -4 Change the parameter value continuously

FAVORITE Add/remove the current Voice/Performance/
Multi to/from the favorite category

PANEL LOCK Move to Utility Panel Lock display

NOTE All the functions are listed in the Data List (PDF file).

@ Data dial

For editing the currently selected parameter. To increase the
value, turn the dial right (clockwise); to decrease the value, turn
the dial left (counter-clockwise). If a parameter with a wide value
range is selected, you can change the value in broader strokes
by quickly turning the dial.

@ [INC] button

For increasing the value of the currently selected parameter.

@ [DEC] button

For decreasing the value of the currently selected parameter.



@ Cursor buttons
The cursor buttons move the “cursor” around the LCD display
screen, highlighting and selecting the various parameters.

@ [EXIT] button

The menus and displays of the S90 XS/S70 XS are organized
according to a hierarchical structure. Press this button to exit
from the current display and return to the previous level in the
hierarchy. Also use it to cancel a Job or a Store operation.

€ [ENTER] button

Use this button to call up the display of the selected menu. Also
use this button to execute a Job or a Store operation.

% ?

PERFORMANCE CREATOR

i DRUM
VOICE | PERFORM  MASTER LAYER  SPLIT  ASSIGN

—HT)

MULTI/  START/ _ AUDIO
SEQ PLAY STOP  REC/PLAY

CLICK
MIXING  FILE  UTILITY

-

DEMO

EDIT JOB  STORE

COMPARE

@ Mode buttons
These buttons select the S90 XS/S70 XS operating modes (e.g.,
Voice mode).

@ PERFORMANCE CREATOR

This function is for quickly editing/creating a new Performance
based on the current Voice. This would come in handy when a
certain Voice has effect settings that you want to use in your
Performance program.

[LAYER] button

This function is for editing a layer Performance based on the
current Voice. When pressing this button, the Category
Search display appears on the display and you can select
the Voices for use in a layer.

[SPLIT] button

This function is for editing a split Performance based on the
current Voice. When pressing this button, the Category
Search display appears on the display and you can select
the Voices for use in a split.

[DRUM ASSIGN] button

This function is for editing a Performance with a Drum Voice
based on the current Voice. When pressing this button, the
Category Search display appears on the display and you
can select the desired Drum Voice. Also, Arpeggio will be
set to on automatically.

Controls and Functions

BANK CATEGORY
@ DEC INC | | 'SEARCH FAVORITE

(&)

A B [ D E F G H PANEL LOCK
[ 9 10 n 12 13 14 15 16 MUTE soLo
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@ BANK [DEC]/[INC] buttons

Each button selects a Voice or Performance Bank.

& [CATEGORY SEARCH] button

When this button is turned on in the Voice/Multi/Performance
Part Edit mode, the [A] — [H] buttons can be used to select the
main category of the Voice. When this button is turned on in the
Performance mode, the [A] — [H] buttons can be used to select
the main category of the Performance.

© [FAVORITE] button

Use this convenient function to store all your favorite, often-used
Voices in a single, easy-to-access location and call them up by
pressing the [FAVORITE] button. You can add the current
program to a favorite category by simultaneously holding down
the [SHIFT] button and pressing this button. This is one more
useful way you can quickly select the Voices you need from the
huge number available on the instrument.

@ [A] - [H] buttons

Each button selects a Program.

When the [CATEGORY SEARCH)] button is turned on, these
buttons can be used to select the Main category (printed below
each button).

€ [PART] button
[MUTE] button
[SOLO] button

Changes the function of the Number [1] — [16] button. (Refer to
“Number [1] — [16] buttons” section.)

@ [PANEL LOCK] button

Turning on this button disables the panel operations. The Panel
Lock function can temporarily disable panel operations and
prevent unintended operation during live performance. The
Panel Lock function affects all controls, with the exception of the
Modulation wheel, the Pitch Bend wheel, Footswitch, INPUT
GAIN and the MASTER VOLUME. The target buttons for the
Panel Lock function can be set up in the Utility Panel Lock
display.
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Controls and Functions

€ Number [1] - [16] buttons

Use of these buttons differs depending on the on/off status of the
[PART], [MUTE] and [SOLQ] buttons. The indicator lights if each

button is turned on

T )
[-ﬁ-ﬁ-ﬁ-ﬁ-ﬁ-ﬁ-ﬁ-ﬁ-

PART

MUTE  SOLO

2]

Mode

[PART]

[MUTE]

[SOLO]

Voice Play

Keyboard transmit channel setting

Normal Voice Edit

Element selection ([1] - [8])
Element Mute setting ([9] - [16])

Element selection ([1] — [8] or [9] — [16])

Performance Play

Keyboard transmit channel setting

Part Mute setting ([1] - [4])

Solo part selection ([1] — [4])

Performance Edit

Part selection ([1] - [4])

Part Mute setting ([1] - [4])

Solo Part selection ([1] - [4])

Edit to Zone Edit and Zone selection ([1] —
[4])

Multi Play Part selection ([1] - [16]) Part Mute setting ([1] — [16]) Solo part selection ([1] — [16])
Multi Edit Part selection ([1] - [16]) Part Mute setting ([1] — [16]) Solo part selection ([1] - [16])
Master Play Keyboard transmit channel setting (when | Part Mute setting ([1] - [4]) (Performance) | Solo Part selection ([1] - [4])
memorizing the Voice mode or Part Mute setting ([1] — [16]) (Multi) (Performance)
Performance mode to the current Master) Solo Part selection ([1] — [16]) (Multi)
or Part selection (when memorizing the
Multi mode to the current Master)
Master Edit Changes the Edit mode from Common — —
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Rear Panel

Controls and Functions

(0]
® ) @
AC IN / N
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@ O (Power switch)
Press to turn power ON (=) or OFF (ML).

© AC IN socket
Connects to the included power cord.
Use only the AC power cord supplied with the S90 XS/S70 XS.

© MIDI IN, OUT, and THRU terminals

MIDI IN is for receiving control or performance data from another
MIDI device, such as an external sequencer. Use this connector
to control the synthesizer from an external MIDI device. MIDI
OUT is for transmitting all control, performance and playback
data from the S90 XS/S70 XS to another MIDI device, such as an
external sequencer.

Likewise, you can use the S90 XS/S70 XS to control external
MIDI instruments. MIDI THRU is simply for redirecting any
received MIDI data (via MIDI IN) to connected devices, allowing
convenient chaining of additional MIDI instruments.

O FOOT SWITCH jacks

For connection of an optional FC3/FC4/FC5 Footswitch to the
SUSTAIN jack and a FC4/FC5 Footswitch to the ASSIGNABLE
jack. When connected to the SUSTAIN jack, the Footswitch
controls sustain. When connected to ASSIGNABLE, it can
control one of various different assignable functions.

© FOOT CONTROLLER 1 and 2 jacks

An optional foot controller (FC7, etc.) can be connected here.
Each jack lets you continuously control one of various different
assignable functions--such as volume, tone, pitch, or other
aspects of the sound.

O LCD Contrast control
Use this control to set the LCD display for optimum legibility.

@ USB connectors

There are two different types of USB connectors, and the rear
panel of the instrument features both. The USB TO HOST
connector is used to connect this instrument to the computer via
the USB cable. The USB connection between the instrument and
the computer can only be used for transfer of MIDI data. Unlike
MIDI, USB can handle multiple ports via a single cable. The USB
connection between the instrument and the computer can only
be used for transfer of MIDI data. No audio data can be
transferred via USB.

The USB TO DEVICE connector is used to connect this
instrument to a USB storage device (hard disk drive, CD-ROM
drive, flash disk, etc.) via USB. This lets you save the data
created on this instrument to an external USB storage device as
well as load data from the device to the instrument. Save/Load
operations can be performed in the File mode.

© ASSIGNABLE OUT L and R jacks
These outputs are independent of the main output (at the L/
MONO and R jacks below), and can be freely assigned to any of
the Drum Voice keys or the Parts. This lets you route specific
Voices or sounds for processing with a favorite outboard effect
unit.
The Parts which can be assigned to these jacks are as follows:
¢ Drum Voice key to which the drum/percussion instrument is
assigned
e Each part of the Performance*
e Each part of the Multi*
e Click (metronome)
*Includes the Audio Input Part (A/D IN Part)

© OUTPUT L/MONO and R jacks

Line level audio signals are output via these phone jacks. For
monophonic output, use just the L/MONO jack.

@ PHONES jack

A pair of headphones can be plugged in here. (Standard stereo
phone jack)

® MIC INPUT jack

External audio signals can be input via this combo jack. A
microphone can be connected to the MIC INPUT jacks. This
audio can be used as input for the A/D Input Part in the
Performance/Multi mode. Use an XLR plug or 1/4" mono phone
plug.
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Setting Up

Power Supply

Connect the supplied AC power cord in the following
order. Make sure the Power switch on the S90 XS/S70 XS
is set to OFF.

1 cConnectthe supplied power cord to the AC IN
on the instrument’s rear panel.

2 Connect the other end of the power cord to
an AC outlet.

_— Power switch

NOTE Follow this procedure in reverse order when disconnecting the
power cord.

A CAUTION

Make sure your S90 XS/S70 XS meets the voltage requirement for the
country or region in which it is being used. The power cord includes a
grounding pin to prevent electrical shock and damage to equipment.
When connecting to an outlet, connect the adaptor’s ground lead to
the ground screw. If you’re unsure how to connect, then contact your
Yamaha dealer or service center (page 63).

& WARNING

Use only the AC power cord supplied with the S90 XS/S70 XS. The
use of an inappropriate replacement can pose a fire and shock
hazard!

A CAUTION

Even when the switch is in the OFF position, a small amount of
electricity is still flowing to the unit. When you are not using the S90
XS/S70 XS for a long time, make sure to unplug the AC power adaptor
from the wall AC outlet.
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Connecting speakers or
headphones

Since the S90 XS/S70 XS has no built-in speakers, you
will need to monitor the sound of the instrument by using
external equipment. Connect a set of headphones,
powered speakers, or other playback equipment as
illustrated below. When making connections, be sure that
your cables have the appropriate ratings.

Powered speaker (Left) Powered speaker (Right)

Headphones

o 2 Sgoxs

i

S90 XS/S70 XS

Powering Up the System

Make sure the volume settings of the S90 XS/S570 XS and
external devices such as powered speakers are turned
down to the minimum before turning the power on.
When connecting the S90 XS/S70 XS to the powered
speakers, turn on the power switch of each device in the
following order.

When turning the power on:
First, the S90 XS/S70 XS, then the connected powered
speakers.

When turning the power off:
First, the connected powered speakers, then the S90 XS/
S70 XS.

Please keep in mind that the Power switch is located at
the right side (from the view of the keyboard) of the AC IN
socket on the rear panel of the S90 XS/S70 XS.



Adjusting the volume and
the brightness of the
display

Adjust the volume levels of the S90 XS/S70 XS and the

connected amplifier/speaker system.

NOTE When connecting to a set of powered speakers or PA
equipment, set the MASTER VOLUME to about 70%, then raise
the volume of the powered speakers or PA equipment to the
appropriate level.

If the display is not easily visible, use the LCD

CONTRAST knob on the rear panel to adjust for optimum

visibility.

Adjust the display Adjust the volume with

contrast withthe LCD the MASTER VOLUME
CONTRAST knob. slider.

Dark .} Light

LCD
CONTRAST

- Max.

Vv

oM

il

& CAUTION

Do not listen with the headphones at high volume for long periods of
time. Doing so may cause hearing loss.

S90 XS/S70 XS

Starting Up

Try playing some of the realistic and dynamic S90 XS/S70
XS sounds from the keyboard now. When you turn the
power on, the display below appears.

Program name

l_|—|
145 TER WIELE A D]

Master program number

Category: Piano <A poo:

Hatural Grand S6

Mode Bank

Program number

NOTE In the default settings, the Master mode is selected. See
page 19 for details about the modes.

NOTE Keep in mind that the example displays shown in this manual are
for instruction purposes only, and may appear somewhat
different from those on your instrument.

In this condition you can play the keyboard and hear the

sounds of the selected program.

In the default setting, the Master mode provides a total of

128 programs each of which includes the mode (Voice,

Performance, Multi) and its program number.

Setting Up

The top of the Master Play display indicates the Master
program number and the status (Mode, Bank, Program
Number and its name) registered to the current Master
program.

NOTE For details about Banks, see pages 21 and 32.

Selecting Voices

In the default setting, the Master mode provides a total of
128 programs each of which includes the mode (Voice,
Performance, Song and Multi) and its program number.
Try out the different Master programs to play various
Voices and Performances. You can change the Master
program number by using the [INC] button, [DEC] button,
or the data dial.

Decreases number Increases number

DEC INC
Decreases Increases

Playing demo songs

The S90 XS/S70 XS features a variety of demo songs,
showcasing its dynamic sound and sophisticated
functions. Here’s how to play them back.

NOTE Make sure the S90 XS/S70 XS is ready for playback. Details are
given in the section “Setting Up” on page 16.

1 Simultaneously hold the [FILE] button and
press the [UTILITY] button.

2 The DEMO screen is shown in the display.
Select the song with the data dial or cursor
[A)[ V] buttons.

3 Press the [ENTER] button to start playback of
the DEMO song.
Pressing the [ENTER] button during playback stops
playback at the current point in the Song then
pressing this again starts playback from that point.

4 1o stop playback, press the [EXIT] button.
5 To close the Demo Song display, press any of

the [EXIT], [VOICE], [PERFORM], [MASTER]
and [MULTI/SEQ PLAY] buttons.
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Setting Up

Resetting the User
Memory to the Initial
Factory Settings

The S90 XS/S70 XS has a Factory Set function for
restoring your S90 XS/S70 XS’'s memory to the factory
default settings.

This lets you restore the S90 XS/S70 XS’s default
program, as well as its System and other settings.

A CAUTION

When the factory settings are restored, all the data that you created in
each mode or saved to internal flash memory will be erased. Take
care so as not to lose important data. Be sure to save all important
data to a computer before executing this procedure (page 47).

1 Press the [UTILITY] button.
The Utility Select display appears.

Utility Select

IEEEEN [ WET ] [Controfler]

[MicroTune][ Voice [ Remote |

[Buick Set|[Panel Lock| [Fotry Set|
PRESS [ENTERL

2 select “Fctry Set” by using the Cursor [A)/
[V /[ «€)/[™] buttons, then press the [ENTER]
button.

The Factory Set display appears.

[_Utility Factory Set

duto Factory Set

PRESS [ENTER] TO EXEC FACTORY SET.

A CAUTION

When setting the Auto Factory Set parameter to on and pressing the
[ ENTER] button, the Factory Set will automatically be executed each
time the power is turned on.

Keep in mind that this also means that your original data in Flash
ROM will be erased each time you turn on the power. Therefore, the
Auto Factory Set parameter should normally be set to off. When
setting the Auto Factory Set parameter to off and pressing the

[ ENTER] button, the Factory Set will not be executed when turning the
power on next time.

Please note that the setting of the Power On Auto Factory Set on this
display will be stored automatically by executing Factory Set.

3 Press the [ENTER] button to execute the
Factory Set operation.
The display prompts you for confirmation. Press the
[ENTER] button again to execute Factory Set.
After Factory Set has been completed, operation
returns to the Master Play display.
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Press the [EXIT] button to cancel the Factory Set
operation.

A CAUTION

For Factory Set operations that take longer to process, you will see
the message “Now executing Factory Set...” during processing.
While such a message is shown (while data is being written to Flash
ROM), never attempt to turn off the power. This means that this tone
generator may not be able to start up properly, even when turning the
power on next time.



Start Guide

There are several operation modes in the S90 XS/S70 XS, and they can be selected by using the seven mode buttons.
These modes include: Voice, Performance, Multi, Master and Sequence Play. Depending on the selected mode, you can
play and perform on the keyboard and create your own original music.
If you want to play the keyboard conventionally, use the Voice or Performance mode. If you're creating music, particularly
multi-part arrangements, use the Multi mode.
In addition, the following modes are available: the Audio Record/Play mode for recording your keyboard performance as
audio data and playing back audio files, the File mode for managing files for saving the data you created on this
synthesizer, and the Utility mode for making overall settings.

e N\ e N
Playing Voices from the Playing multiple Voices from Creating original program sets
keyboard the keyboard
_ Master mode
Voice mode Performance mode [MASTER] button
[VOICE] button [PERFORM] button This special mode lets you register and use
This synthesizer has a wealth of high- This mode lets you play and create the programs you created in each of the
quality, dynamic sounds—also referred to Performances. A Performance lets you put Voice, Performance, and Multi modes. The
as “Voices.” You can play these Voices— several different Voices together in layers or Master mode can be used in two ways:
one Voice at a time—from the keyboard in play different two Voices in a keyboard Storing your favorite programs
the Voice mode. This_ mode_also lets you split. This lets you register settings that you often
create your own original Voices. use in the Voice, Performance, or Multi
\_ J U mode, and instantly recall the relevant
mode and custom settings together in a
single button press—without having to first
select a mode.
Playing as a master keyboard
This lets you divide the keyboard into four
separate sections—just as if you were
playing four different MIDI keyboards.
. J
e N VOICE |PERFORM MASTER e N
. . . . —J —J —J .
Creating an original Song via l -l—. l l -—I— Recording your performance/
an external sequence recorder playing back audio data
Multi mode SEG PLAY STOP  REC/PLAY Audio Record/Play mode
[MULTI/SEQ PLAY] button I F l — [AUDIO REC/PLAY] button
The Multi mode lets you use this instrument This mode lets you record your keyboard
as a multi-timbral tone generator for performance to the root dilrectorly of an
sequencer song playback. By assigning a external USB storage device or internal
different Voice to each track in a song file MIXING FILE UTILITY flash memory and play back audio files
on your external sequencer, you can play from the specified device.
back complex multi-part ensemble
recordings. DEMO
\ J
Playing back audio/MIDI files
e e N
Sequence Play mode ; .
[MULTISEQ PLAY] button Backing up data Setting the system parameters
This mode lets you play back SMF files . s
created via an external sequencer or other File mode Utlllty mode
device and 44.1kHz/16-bit stereo audio [FILE] button [UTILITY] button
files sequentially. You can d_irectly play The File mode lets you save data you've The Utility mode lets you set parameters
back the files stored to the internal flash created on this instrument to a USB storage that apply to the entire system of this
g
memory and saved to an external USB device or the internal flash memory, and instrument. These parameter settings are
storage device. allows you to load data from the USB applied to all Voices, Performances, and
device to the instrument. Of course, you Multis.
} can store your important data to the
NOTE Pressing the [MULTI/SEQ PLAY] instrument; however, for best safe-keeping,
button toggles between the Multi Yamaha recommends that you back up all
mode and Sequence Play mode. important data to a USB storage device.
\ \ \ J
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Basic Instructions

Voices—the basic building blocks of the S90 XS/S70 XS

Voices—created in the Voice mode—are the basic sonic building blocks for the other modes of this instrument. The
Performance and Multi programs are made up of different Voices.

This instrument features an exceptionally wide variety of preset Voices for playing in virtually any musical style. Try searching
through the Voices to find your favorites. Once you've explored them and feel comfortable with them, try branching out
creatively and use the editing features to make your own original Voices.

Selecting a preset Voice page 21

Changing the tonal qualities of the Voice page 23

Combining several Voices to create a Performance or Multi

If you want to play several different Voices together simultaneously, select a Performance. The 384 Performances are
preprogrammed and be used as such, but can also be changed and customized to suit your own needs. By using the
Performance Creator feature, you can create your own original Performance based on the Voice currently selected in the Voice
mode.

To use this instrument as a multi-timbral tone generator with computer DAW software, select a Multi. With the help of the Multis,
this instrument can be used to play back MIDI song files from a connected USB or internal flash memory device.

Creating a new Performance in the Voice
mode by using your favorite Voices page 28
(Performance Creator)

Selecting a Performance page 32
Creating music using a Multi and your page 38
computer

Playing back a MIDI file page 41

Master mode—create a master keyboard setup or instantly call up your desired programs
The Master mode lets you register your favorite Voices, Performances, and Multis together into easy-to-select Master programs. No
matter what mode is used—Voice, Performance or Multi—you can have it instantly and automatically selected when you call up the
appropriate Master. The Master mode can also be used to divide the keyboard into four sections—each with its own Voice—ijust as if
you were playing four different MIDI keyboards.

Making Master mode settings page 43

Convenient remote control of your computer DAW software

The panel of this instrument also serves as a convenient control surface for your computer music system. Use the buttons and
controllers to control the audio mixer, pan adjustment, song start/stop and the VST instrument’s parameters in your DAW
software. This highly intuitive approach gives you hands-on control over your virtual studio—a level of control that a keyboard
and mouse cannot match.

Remote-controlling the software page 38

Global settings and data backup

While the Voice, Performance, and Multi modes provide controls for using and editing the programs of this instrument, the Ultility
mode is the place where you make overall settings for this instrument—for example, adjusting the transpose and fine tuning
controls, or switching between MIDI and USB operation. You can also archive your important data created on this instrument to
a USB storage device for safe-keeping.

Making global system settings page 45

Backing up important data page 47
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Playing the Keyboard in the Voice mode

In the Voice Play display (the top display of the Voice
Mode), you can select and play a single Voice.

The Voices of this instrument are divided into the
following two types:

Normal Voice

Normal Voices are mainly pitched musical instrument-
type sounds (piano, organ, guitar, etc.) that can be
played over the range of the keyboard.

Drum Voice

Drum Voices are mainly percussion/drum sounds that are
assigned to individual notes. These Voices are used to
perform rhythm parts.

This instrument features Banks for memorizing Voices.
There are basically three different types of Banks: Preset,
User, and GM. The contained Voices and features
depend on the Bank as described below.

Preset Banks

The Preset Banks contain a full set of specially
programmed Voices. Voices you've edited yourself
cannot be saved in the Preset Banks.

User Banks

The User Banks contain the Voices you have edited and
stored. These are picked up from Preset Voices by
default.

& CAUTION

If a Voice in a User Bank (User Voice) is overwritten or replaced, that
User Voice will be lost. When you store an edited Voice, be careful not
to overwrite any important User Voices.

GM Bank

The GM Bank contains the Voices allocated according to
the GM standard.

GM Voice

GM (General MIDI) is a worldwide standard for Voice
organization and MIDI functions of synthesizers and tone
generators. It was designed primarily to ensure that any
song data created with a specific GM device would sound
virtually the same on any other GM device—no matter the
manufacturer or the model. The GM Voice bank on this
synthesizer is designed to appropriately play back GM
song data. However, keep in mind that the sound may not
be exactly the same as played by the original tone
generator.

In the Voice mode, a total of 16 Banks (Preset Bank 1 -8,
User Bank 1 -4, GM Bank, Preset Drum Bank, User
Drum, GM Drum Bank) are available. Each of these Banks
includes the Voices according to the Voice type. In the

Voice Play display, you can select the desired Voice from
various Voice Banks and play it.

NOTE For details about the Voice, refer to “Basic Structure.” For a list of
the Preset Voices, refer to the separate Data List PDF file.

Selecting a preset Voice

1 Press the [VOICE] button.
This calls up the Voice Play display. (The [VOICE] button
lamp lights.)

2 Select a Voice Bank with the BANK [DECY/
[INC] buttons.
In this condition, playing the keyboard sounds the Voice
indicated in the display.
The parameters shown in the Voice Play mode are briefly
explained below.

B Voice Play display

Program
Main Category Bank number Sub Category

| | |

FEE 1881 (461

L

Matural Grand $6

s T coo J reo Y men
I

Voice Indicates status of corresponding effect. Arpeggio
name (Not shown when effect is off.) tempo

B Normal Voice Banks
There are 13 different banks for the Normal Voices: PRE1 -8
(Preset Banks), GM (GM Bank), USR1 - 4 (User Banks).

B Drum Voices Banks

There are 3 different banks for the Drum Voices: PDR (Preset
Drum Bank), GMDR (GM Drum Bank), UDR (User Drum
Bank).

NOTE If the “Bank Wrap Around” parameter of the Utility General
display is set to “on,” you can change from the last Bank to
the first Bank continuously.

3 Select a Voice with the data dial or [DECY/
[INC] buttons.

NOTE You can use the data dial or [DEC]/[INC] buttons to select
the Voice number. This operation lets you call up Voices in
subsequent or previous Banks.

NOTE To quickly move forward through the program (Voice)
numbers in 10-step jumps, simultaneously hold down the
[SHIFT] button and press the [INC] button in the Play
display. To decrease by 10, do the opposite; simultaneously
hold down the [SHIFT] button and press the [DEC] button.

4 Pilay the keyboard.
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Playing the Keyboard in the Voice mode

Using the Category Search
function

The Voices are conveniently divided into specific
Categories, irrespective of their bank locations. The
categories are divided based on the general instrument
type or sound characteristics. The Category Search
function gives you quick access to the sounds you want.

1 Pressthe [CATEGORY SEARCH] button in the
Voice Play display.
The Category Search dialog appears.

Main Category

Mie= PRE 1 AR raEiy
© Yaice Category Seatrch k

Main

Sub SALLE —

Sub Category

2 Move the cursor position to “Main” (Main
Category) with the Cursor [ A] button, and
use the data dial to select the Main Category.

3 Move the cursor position to “Sub” (Sub
Category) with the Cursor [ V] button, and
use the data dial to select the Sub Category.

4 Press the [ENTER] button, or Cursor [»]
button to actually call up the selected
Category.

The Voice List of the selected category is shown.

Currently selected Main Category
and Sub Category

1 Drgan _<EOMBD v:'|

Favorite check box

A = O
22 T|n*=| I:-:iml:n:u Bars 1 O
3 Tind Combo Bars 2 E
O

—_—

e
2d Panther
25 1967 Keys

Voice list of currently selected category.

5 Select the Voice with the Cursor [AJ[V]
buttons or data dial.
If you want to change the Category, press the Cursor [ 4]
button or [EXIT] button and go back to step 2.

6 Press the [ENTER] button to actually call up
the Voice.
This closes the Category Search dialog.
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Grouping your most-used
Voices together—Favorite
Category

Category Search also has a convenient Favorite
Category that lets you collect your most often used and
favorite Voices for easy selection. This is one more useful
way you can quickly select the Voices you need from the
huge number available on the instrument.

Registering your favorite Voices to the
Favorite Category

1 Perform steps 1 through 4 of the “Using the
Category Search Function” to call up the
Voice List of the selected Category.

2 Press the Cursor [» ] button to move the
cursor position to the Favorite check box
column.

3 Select the desired Voice with the Cursor [AY
[V] buttons or data dial.

4 pPress the [ENTER] button to place a check in
the Favorite check box.
The checkmark will be entered in the box, and the selected
Voice will be registered to the Favorite Category. To remove
the checkmark from the box, press the [ENTER] button once
again.
To register other Voices, repeat steps 3 through 4.

Favorite check box column

|
sk FRE 1 1odrHi= 1%k |
1 Oraan  <ALL: & [
FPEE1 122 Tiny Combo Bars 1 O

FEE1 125 1967 Keus O
FEE1 12& YD -45C d

NOTE The Favorite Category is automatically stored immediately
after checking the box.

9 When you complete registering Voices to the
Favorite Category, press the [VOICE] button
to return to the Voice Play display.

The Voice selected in the Category Search dialog is shown.

To register/remove the current Voice to/from the Favorite
Category, simply hold the [SHIFT] button then press the
[FAVORITE] button.



Selecting a Voice from the Favorite
Category

1 Pressthe [FAVORITE] button in the Voice Play
display.
The list of Voices registered to the Favorite Category will be
shown.

2 Select the Voice with the Cursor [AV[VY]
buttons or data dial.

3 Press the [ENTER] button to actually call up
the Voice.

Calling up the Simple Display

From the Voice Play display, you can call up the Simple
Display by holding the [SHIFT] button then pressing the
Cursor [«]/[»] buttons. This Simple Display shows the
Voice name with a larger-than-normal character size.
Three character types are available for selection.

PRE 1 : 881 (AB1) E

Full Concer

Fianao <A POO

Simple Display 1

PRE 1 : 981 (A81) E

Full Concert

Fianao <A POO:

Simple Display 2

PRE 1 : 881 (A81) B

Full Concel

Fiano <A Poo:

Simple Display 3

Playing the Keyboard in the Voice mode

Changing the tonal
qualities of the Voice

Knobs 1 — 4 let you adjust a variety of parameters for the
current Voice, such as effect depth, attack/release
characteristics, timbre, and others. Five functions can be
assigned to each Knob, alternatively selected via the
Knob Function buttons.

1 Press the Knob Function buttons (located at
the left of Knobs 1 — 4), repeatedly if
necessary, so that the lamp corresponding to
the desired functions lights.

The Knob Select pop-up display will appear. In the pop-up
display, the function currently assigned to the Knob and the
current value of the function are shown.

To close the pop-up display, press the [EXIT] button.

\l/

O TONE CUTOFF RESONANCE ASSIGN 1 ASSIGN 2
|:| QO EG ATTACK DECAY SUSTAIN RELEASE

O EQ Low MID F MID HIGH
‘:I (O EFFECT CHO PRESET  CHO RETURN  REV PRESET  REV RETURN

O Mic VOLUME PAN CHO SEND REV SEND

Knob Function buttons
Functions assigned to  Current values of the

Knob 1 -4 functions
kS rlian s el RS Y
CUTOFF RESO A51 RAG2
L O O O
+0 +0 +0 +0 |
[ +0 +0 +0 +0 1

Unedited value (previously saved)

NOTE When the “Knb/Sldr Func Disp Sw” is set to “off” in the Utility
General display, the Knob Select pop-up display will not be
shown.

2 Turn a desired Knob while playing the
keyboard.
The Knob pop-up display will appear, and the function
assigned to the Knob you're currently operating will affect
the sound of the current Voice. The Knob pop-up display
shows the function assigned to the Knob you're currently
operating, the function value, and the “Original” value. The
“Original” value indicates the unedited value (previously
saved value) of the function assigned to the Knob.

Function of currently operated Knob Current value

|
i Cutoff y

th—

[[Original . +@ 1l

Unedited value (previously saved)
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Playing the Keyboard in the Voice mode

The Edit () Indicator

When changing the value of the parameter in the Voice/
Performance/Multi Play or Edit display, the Edit Indicator
will appear on the top right corner of the LCD. This gives a
quick confirmation that the current Voice/Performance/
Multi has been modified but not yet stored. To store the
current edited status, follow the instructions.

Voice Editing

“Editing” refers to the process of creating a Voice by
changing the parameters that make up the Voice. This
can be done in Voice Edit, a sub mode within the Voice
mode. The actual parameters that are available differ
depending on the Voice type.

Normal Voice Edit

A Normal Voice (pitched musical instrument-type
sounds) can consist of up to eight Elements. There are
two types of Voice Edit displays: Common Edit, for editing
the settings common to all eight Elements; and Element
Edit, for editing individual Elements. In Element Edit, you
can edit the parameters only on the S90 XS/S70 XS
Editor.

NOTE The output level of the Element can be edited on the panel of this

instrument. For further details, refer to “Adjusting the Element
level.”

Drum Voice Edit

There are two types of Drum Voice Edit displays:
Common Edit, for editing the settings that apply to all
Drum keys in the Voice; and Element Edit, for editing
individual keys (Elements). In Key Edit, you can edit the
parameters only on the S90 XS/S70 XS Editor.

About Elements

An Element is the basic and the smallest unit for a Voice,
and is created by applying various parameters (Effect, EG,
etc.) to the waveform of the instrument sound. Each Voice
of this instrument consists of several Elements.

S90 XS/S70 XS Owner’s Manual

Adjusting the Element level

1 Press the [EDIT] button in the Voice mode.

2 Press the Slider Function button a few times
so that the lamp turns off.

3 Use Number [1] — [8] buttons to select the
Element you want to edit.

4 use the Slider to set the output level for the
selected Element.
When any of the Number [1] - [4] buttons are selected, the
levels of Elements 1 — 4 will be assigned to the Sliders 1 - 4.
When any of the Number [5] - [8] buttons are selected, the
levels of Elements 5 — 8 will be assigned.

Enhancing the sound with
Effects

This instrument features a wide variety of Effects, letting
you add reverb and chorus processing to the selected
Voice for your keyboard performance. Simply changing
the Effect type applied to the preset Voice lets you
instantly come up with different sounds. The instructions
below explain how to set the Effect type and the related
parameters applied to the Preset Voice then store the
settings as a User Voice.

1 Press the [VOICE] button to enter the Voice
Play mode.

2 Select the Voice for which you wish to change
or edit the Effect.

3 Press the [EDIT] button.
The Voice Edit Select display appears.

mnnmmnn Edit Select

| Hame | |Play Mode| | Arpeasial
[Contraller] LFQ [Filter /EG|
3 Band ER

PRESS CENTER].




4 Move the cursor to “Effect” then press the
[ENTER] button.
The Voice Edit Effect display appears.

DS, common Ef fect

Ins Connect Tuype lins & - B
[@]-[Chorus [9]-[oe]
[@]-[Eeverb]—[oa]

NOTE When the Arpeggio/Effect Function is set to “EFFECT ON/
OFF,” the Voice Edit Effect display can be called up also by
holding the [SHIFT] button and pressing the [INS] button
simultaneously.

5 Move the cursor to “Ins A” then press the
[ENTER] button.

The parameters of the current Effect are shown.

D, common Effect
Tupa . WO Touch Wah

n-- A —[2]- |Ehu:-r'u5 [0 - [ |

—IIn5 B]+[2]- IEe'u'er'hI—I'ﬂ'IﬂI
PRESS [ENTERI,

ENTER

4

DIV iR, COMMON Ins & 145 a
Tupe | YCH Phaser Mono

YCH Phaser Mono
FPreset E Fiano

6 Move the cursor to “Category” then select
the Category by using the data dial.

NI m =i, COMMON »Ins & 145 a
Tupe : YO Phaser Mono

YW Phaser Mono
FPreset E Piano

71 Move the cursor to “Type” then select the
Effect Type by using the data dial.

P, common«Ins & 1/5 E|
Tupe | YCM Phaser Stereo

Switch

FPreset Deep Sweeper

Playing the Keyboard in the Voice mode

8 Move the cursor to “Preset” then select the
Preset by using the data dial.
The Preset includes the typical settings of parameters for the
currently selected Effect Type. Try out several Presets so that
you can find how each Effect affects the sound.

EInE=, common«Ins & 175 E|
Tupe | YCM Phaser Stereo

Switch
Cateaory

Fhaser

9 It desired, set each of the parameters.
Try narrowing in on your desired sound by finely editing the
parameters provided for each Effect Type.

common$Ins & 245 E|
Tupe | YCW Phaser Stereo
i

.125H=z

Feedback

PIuiie =, common $1Ins & 345 a3
Tupe | YCOM Phaser Stereo

Mode
Color
Spread

=k

10 After setting the parameters, press the
[STORE] button to store your settings as a

User Voice.
If you edit the preset Voice, your editing will be stored as a
User Voice.
[ Vaice Store N
FRE1_B3&
-

Initialized Yoice

PRESS [ENTEF] TO STORE.

11 select the destination memory by using the
data dial, press the [ENTER] button to call
up the confirmation message, then press
the [ENTER] button again.

NOTE Perform the same operations as above if you want to edit the
Insertion B Effect.
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Playing the Keyboard in the Voice mode

Using the Arpeggio
function

The Arpeggio function automatically triggers preset
arpeggio phrases, riffs, and rhythmic patterns according
to the notes you play.

It not only provides inspiration and full rhythmic passages
over which you can perform, it gives you quality MIDI
data you can use in creating songs, or fully formed
backing parts to be used in your live performances. You
can assign the desired five Arpeggio Types to each
Voice. You can also assign the desired five Arpeggio
Types to each Part of each Performance/Multi and play
back the Arpeggios of up to four Parts simultaneously.
You can also set the Arpeggio playback method, Velocity
range and Play Effects to create your own original
grooves. What's more, Arpeggio playback can be
transmitted through the MIDI Out, letting you record the
Arpeggio data to a sequencer.

Transmitting Arpeggio playback as MIDI data

The Arpeggio phrase can be transmitted as MIDI data by
setting the following parameters to on:

H Voice Arpeggio

Voice mode > [UTILITY] - select “Voice” in the Utility
Select display > [ENTER] - select “Arpeggio” in the
Utility Voice Select display > [ENTER] = “Arp MIDI Out
Sw”

H Performance Arpeggio

Performance mode - [EDIT] - select the Part in the
Performance Edit Select display = [ENTER] > select
“Arpeggio” in the Performance Part Edit Select display >
[ENTER] = select “Arp Edit” in the Arp Select display =
[ENTER] = “Arp MIDI Out Sw”

B Multi Arpeggio

Multi mode > [EDIT] = select a Part on the Multi Edit
Select display = [ENTER] - select “Arpeggio” on the
Multi Part Edit Select display - [ENTER] - select “Arp
Edit” on the Arp Select display = [ENTER] = “Arp MIDI
Out Sw”

NOTE The transmit channel for Arpeggio can be set at the “Arp
Transmit Ch” parameter in the same display as “Arp MIDI Out
SW.”

Arpeggio types

This instrument features 6,779 Arpeggio types (in 18
categories) including Synthesizer, Piano, Guitar, Guitar
bass, Strings, Drum, etc.
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Turning the Arpeggio On/Off

To turning Arpeggio playback on or off, press the [ARP
ON/OFF] button on the panel.

COMMON PART SELECT

IS -

N .

ARP
ON/OFF PART ARP

HOLD

Selecting the Arpeggio Type

1 Press the [EDIT] button in the Voice mode.

2 Select “Arpeggio” then press the [ENTER]
button.

3 Select “Arp Select” by using the cursor
buttons then select one of the Arp1 -5
settings by using the data dial.

ISy, common_ Arp Select E]

Are Sw off
Are Select & SEF1

[ areEdit | [ Are 1 Tuee |

4 select “Arp 1 -5 Type” by using the cursor
buttons then press the [ENTER] button.

EEER o i Selzct

Arp Sw off
Arp Select & SEF1

Arp Edit fre 1 Tape |

PRESS CENTERI.

9 Find the favorite pattern by changing the
Main Category/Sub Category/Type by using
the data dial.

common  Arp 1 Tupe E|
prefes2 FC_Hie Hoe 1 _ES
Main Ctary Oraan

Vel Rate
GTime Rate +ER




6 After finding the favorite pattern, press the
[STORE] button to store the setting as a User
Voice.

Copying the Arpeggio Type to another
Arpeggio part

Follow the instruction to copy the Arpeggio Type
assigned to the Arp 1 to the Arp 2 - 5.

1 Select “ARP SELECT” by pressing the
Arpeggio/Effect Function button.

2 Press the Function [1] button.

3 Press one of the Function [2] - [5] buttons
while holding down the [STORE] button.

Changing the Arpeggio type

To change the Arpeggio from five types, use the
Arpeggio/Effect Function button and Function button.

Arpeggio/Effect Function button

A
| ~ @ ARP SELECT 1 2 3 a 5
(O EFFECT ON/OFF INS CHO REV MFX MEQ

CH R H H—

DAW REMOTE < =1 | Wm W= e
Function button

1 Press the [ARP ON/OFF] button on the panel
to turn the Arpeggio on.

2 Select “ARP SELECT” by pressing the
Arpeggio/Effect Function button.

3 Change the Arpeggio type by using the
Function button.

Playing the Keyboard in the Voice mode
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Creating a New Performance by Using Your Favorite

Voice (Performance Creator)

This instrument features a convenient Performance Creator function which lets you create a o oo
new Performance by using favorite Voices you've found in the Voice mode. This function LAYER  SPLT  ASSION
lets you copy parameter settings associated with the Voice (such as Effects) to the

Performance—allowing you to quickly and easily come up with precisely the sound you

want. Performance Creator provides three convenient features: Layer, Split, and Drum Assign.

Layer_Playing diﬂerent 4 select the desired Voice from the list, then
" press the [ENTER] button.

Vo‘ces together The Performance Play display will appear.

This section explains how to create a Performance in USR 1 @@ 2 @

which different Voices are layered together across the
keyboard. By creating such a Performance, you can play

a rich, thick sound of a layered piano and strings, for HEH FEI""FDI"ITIEI'II:E
example.
[ 1ns J cho [ REv | [_men_|

Category:

1 Select a Voice in the Voice mode.

5 Press the [STORE] button to store the

BEESIEERIREaN settings as a Performance.

Categord:  Piano <A poo:
Natural Grand $S6 [_Perf Stare 3
USRE1_Ba1
[ s N cho B REU | [ mEQ | IIE:F.:-'l
InitializedPerform
2 Press the [LAYER] button on the panel. PRESE [EDIT) TO COMPARE.

The Category Search display appears.
NOTE When you press the [EDIT] button in the Store display, you

/= (IF1:'Aa1 2= B3 can check the sound of the Performance at the storing
[ Layer ) destination.

Min

Sub <ALL

3 Select the Category including the Voice you
want to layer then press the Cursor [»>]
button.

The Voice list is shown.

Strna  <EnsEm:

FEEd 815 Small Section
FEEd B1& Small Ensemble
FEEd4 817 Almishta ;
FEEd E18 Medium Section

D
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Creating a New Performance by Using Your Favorite Voice (Performance Creator)

Split—Playing two
different Voices with your
left and right hands

This section shows you how to create a Performance in
which the keyboard is divided into two sections—the left-
hand section and the right-hand. The lowest note of the
right-hand section is referred to as the “Split Point.” By
creating such a Performance, you can play a bass part
with your left hand, and a piano part with your right, for
example.

1 Select a Voice in the Voice mode.

mﬂi PRE 1 @32 (CA1)

Cateqory: Keus s

Hard Vintage

2 Press the [SPLIT] button on the panel.
The Split display appears.

FET IR i:aR1 e
& Split v
Main

Sub <ALL*
SPLIT POINT | |
LO,/UP LOWER

3 Move the cursor to “SPLIT POINT” then set
the Split Point.

I IISF1i:61 == e 3
f‘—.
Selit k
Main Bass
Sub +HALL:
sPLIT PoINT I
LO/UP LOWER

You can determine the Split Point by holding the [SHIFT]
button then pressing the desired note on the keyboard.

NOTE The note set to the Split Point is included in the upper
section of the keyboard.

4 WMove the cursor to “LO/UP” then select

whether the desired Voice is assigned to the
lower section or the upper section of the
keyboard.

HE= IISF1:AR1 e @A
[ Selit 3

Hain Bass

Suhb ALL:
SPLIT POINT C @
G  LOWER |

NOTE When the original Voice is a Drum Voice, the Split Point of
the original Drum Voice is not changed even if LO/UP is set.

Move the cursor to “Main”/’Sub” then select
the Category that includes your desired
Voice.

T (SR1:AR1 e @
[ Selit 3

Main Bass

Sub
SPLIT POINT L 2
LO/UP LOWER

6 Press the Cursor [» ] button.

The Voice list is shown.

= IISR1:AR1 m; A
LDERE el L .
4 Bass <A BASS: -

A28 Groovedcoustic AF1
821 Ueriaht :

115 Me3a Acoustic Bass
A232 hooustic Bass

PEEZ
PREZ
FEES
]

1 Select the desired Voice from the list, then

press the [ENTER] button.
The Performance Play display will appear.

SR 1 ;831 re @
Category:
Hew Performance
“ins B cen § ReU | [ men |

8 Press the [STORE] button to store the

settings as a Performance.
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Drum Assign—Layering a
drum Part with the current
Voice

This section explains how to create a Performance in
which you can trigger a drum pattern (via the Arpeggio
function) in addition to the current Voice.

1 Select a Voice in the Voice mode.

ElGEEy, FRE 2125 (H13)

Categqord: Guitr  <E0sT: 4130
Hard Ramp AS1&2
[ mns N cho J rEv | [ mEn_|

2 Press the [DRUM ASSIGN] button on the front
panel.
The Drum Assign display appears. The Dr/Pc (Drum/
Percussion) is automatically assigned to the Category. The
Drum Voice is assigned to Part 4 then the Arpeggio is
automatically turned on. Play the keyboard to trigger the
Arpeggio.

lll‘—.
Drum &ssian k

Main
Sub ZALL>

3 Press the Cursor [» ] button.
The Voice list is shown.

IS - Standard Ej
PDE @82 Power Standard Eit J
FDE 8832 Haper Standard Kit
PCE
FCR

BEd Dry Standard Eit
BES Modern Bock Kit

4 select the desired Drum Voice from the list,
then press the [ENTER] button.

The Performance Play display will appear.

SR 1: @61 [l E |
Categqory:
New Performance
BT TR T [ men |
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Creating a New Performance by Using Your Favorite Voice (Performance Creator)

Changing the drum pattern
(Arpeggio Type)

Executing the Drum Assign function will assign the Drum
Voice to Part 4 and set the Arpeggio of Part 4 to on. If you

want to change the drum pattern, select a different
Arpeggio Type in the Performance Part Edit.

5 Press the [EDIT] button in the Performance
Play display.

The Performance Edit Select display appears.

FERF Edit Select P4 E

Common

L1 b2 = ][d4]

PRESS CENTERI.

6 Select Part 4 by using the cursor buttons
then press the [ENTER] button.

FEREF Edit Select Py E
| Common |

] 1= i

PRESS CENTERI.

ENTER

FERF PRRT _ Edit Select  m B

EEEEEN) [Fizs tode] [Areessio]

[Filtter /EG] [Z Band EQ] [ Row Sw |
F# Send

PRESS CENTER].

1 Select “Arpeggio” by using the cursor
buttons then press the [ENTER] button.

FERF PRRT _ Arp Select  Pi B
Arp Sw
are Select £ AFEF1

[ arp Edit | [Are 1 Tupre |

8 select “Arp 1 Type” by using the cursor
buttons then press the [ENTER] button.

S PART Arp 1 Tupe PE

pred 262 MC _Cool Funk

Sub Ctara4 LRE&E
Tape predZ&3
Vel Rate +E3
GTim= Rate +E7




Creating a New Performance by Using Your Favorite Voice (Performance Creator)

9 Find your favorite pattern by changing the
Main Category/Sub Category/Type with the
data dial.

FERF PRRT  &rp 1 Tupe P
pred2e3 MC_Cool Funk
Hain Ctary

DrPc

| Rate

Ve
GTime Rate +EE

You can change the pattern of the Arp 2 — 5 via the same
operation. To change the Arpeggio from among the five
types, use the Function button. Turn “ARP SELECT” on by
pressing the Arpeggio/Effect Function button then press
the Function button.

Arpeggio/Effect Function button

A
l ~ @ ARP SELECT 1 2 3 4 5
(O EFFECT ON/OFF INS CHO REV MFX MEQ

Function button

Assigning a name to the
Performance

You can assign the name to the Voice and Performance
then store the settings as a User Voice/Performance.

1 Press the [EDIT] button in the Performance
Play display.

The Performance Edit Select display appears.

2 Select “Common” by using the cursor
buttons then press the [ENTER] button.

3 Select “Name” by using the cursor buttons
then press the [ENTER] button.

4 press the [ENTER] button with “Name”
selected.
The Naming dialog appears.

IR | ]

M1 2356729 _ I B4#0 ) CLERR
SBCDEFGH I JELMHOPRESTUYIEY S
abcdefahidk lmnopars tuwwseaz
FR A=, IR I T R

PRESS [ENTER] TO EXEC.

9 Select the desired character by using the

data dial and cursor buttons then press the
[INC] button to enter the selected character.
To cancel the selected character, press the
[DEC] button.

You can enter up to 20 alphanumeric characters.

After entering the characters, press the
[ENTER] button.

Press the [STORE] button.

The destination User Banks and Programs are shown.

[ Perf Stare N

USR1_@&1
Usk1 [EER

Hew Performance
PRESS [ENTER1 TO STORE.

Select the desired Bank and Program then
press the [ENTER] button.

[ Perf Store |

USR1_&&1
Uskd EFFE

InitializedPerform
PRESS [ENTER1 TO STORE.

After the confirmation dialog appears, press
the [ENTER] button.
NOTE When you press the [EDIT] button in the Store display, you

can check the sound of the Voice/Performance/Multi at the
storing destination.
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Playing the Keyboard in the Performance Mode

Selecting a Performance

Selecting a Performance is done in basically the same way as selecting a Voice. The Category Search function is
available also in the Performance Play mode. Note that the S90 XS/S70 XS has no Preset Performances and provides
only three User Banks.

Press to edit the entire Press to select
Performance a Part

COMMON PART SELECT

PART ON/OFF

I I .

ARP
ON/OFF PART ARP

(O ]
I@—E—D—E

Changing the timbre of the Voice

Just as in the Voice mode, the sound of the Performance (consisting of a maximum of four Parts or Voices) can be edited
via the Knobs and Sliders in the Performance mode. There are two ways to edit the Performance: editing the entire
Performance, and editing only one specific Part (Voice) assigned to the Performance. The Part to be edited is selected
via the Performance Control buttons. To edit the entire Performance, press the [COMMON] button then turn the Knob. To
edit a specific Voice of the current Performance, select the desired Part by using the [PART SELECT] buttons then turn
the Knob.

NOTE Hold the [SHIFT] button and press the [COMMON]/[PART SELECT] button to call up the Common Edit Select display/Part Edit Select display. This
is useful for editing the Performance.

The far left four Sliders adjust the Volume, Pan, Chorus Send and Reverb Send for each of the four Parts. Select the
function via the Slider Function button, then move the Sliders.

O voLume
Opran

(O CHO SEND
() REV SEND

[

ZONE 1 ZONE 2 ZONE 3 ZONE 4

Select a function via the
Slider Function button
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Singing with a Connected Microphone

By connecting a microphone to the MIC INPUT jack (combo jack) located on the rear panel of this instrument, you can
enjoy singing along with your own performance. You can also apply the built-in Effects to this signal input via the MIC
INPUT jack, including the distinctive Vocoder Effect. The example below assumes you want to sing while playing the

keyboard.

1 Connect the microphone to the MIC INPUT jack on the rear panel.

2 Press the [MIC ON/OFF] button on the panel so that the lamp lights.

3 Adjust the microphone input level by using the INPUT GAIN knob.
Adjust the input gain so that the PEAK lamp flashes briefly.

4 select “MIC” by pressing the Knob Function buttons then adjust the volume by using the Knob to

which VOLUME is assigned.

]
]

O TONE CUTOFF
[@):=1]
O Ea

O EFFECT

Q@ mic

RESONANCE ASSIGN 1 ASSIGN 2

ATTACK DECAY SUSTAIN RELEASE

Low MID F MID HIGH

CHO PRESET  CHO RETURN REV PRESET REV RETURN
VOLUME PAN

CHO SEND REV SEND

5 As necessary, control the Knobs to which the PAN, CHORUS SEND and REVERB SEND are

assigned.
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Recording/Playing Back with a USB Storage Device

(Audio Record/Play Mode)

The Audio Record/Play mode lets you record your keyboard performance as audio data. The recorded audio data will be
saved as an audio file to the root directory of the external USB storage device or internal flash memory, allowing you to

play back the audio file from the specified storage.

Recording

In this section, you'll learn how to record your keyboard
performance as a stereo Wave file (of 44.1kHz/16-bit).
Your keyboard performance can be recorded for up to 74
minutes at a fixed recording level. The instructions below
explain how to record your keyboard performance to a
USB storage device.

1 Press the [AUDIO REC/PLAY] button.
The Audio Rec/Play Select display will appear.

[_Audio Rec/Plad Select ]

PRESS [ENTER].

2 Select “Rec” then press the [ENTER] button.
The Standby display will appear.

3 Move the cursor to “Rec Storage” then select
the USB storage device as the target (“usb1i-
1” in the example here) by using the data dial
or [DECJ/[INC] button.

NOTE The “internal” setting indicates the internal flash memory.

[_#udio Rec
Eec Storase
— manual

Trigger Lewel

STAMHDEY

RECORDABLE TIME 13:22
PRESS [ENTER] TO REC. -
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4 Wove the cursor to “Trigger Level” then
adjust the Trigger Level.
As soon as the signal level (set here) of your keyboard
performance or MIC INPUT exceeds the trigger level,
recording will begin. For best results, set this as low as
possible to capture the entire signal from the very beginning,
but not so low as to record unwanted noise. In this example,
set the Trigger Level to “10.”

[ Audio Rec I
e T
Trigger Lewvel

STAHDEY
RECORDABLE TIME 20:55
PRESS [ENTER] TO REC. F—1

5 Press the [ENTER] button.
The Recording Standby display appears.

[_Audic Rec N
o | T
Trigger Lewvel

WATTIMG
RECORDABLE TIME 20:54
PRESS [ENTER] TO REC. F—+

6 Play the keyboard.
Recording actually starts as soon as the signal of your
keyboard performance exceeds the Trigger Level set in step
4.

[ Audio Rec

]
e T
Trigger Lewvel

RECORDIMG

RECORDABLE TIME 20:MB —
PRESS [ENTERI TO STOP. F ==+

1 Press the [ENTER] button after your
performance is finished.



8 Press the [ENTER] button when the “Save
Audio Rec file?” message appears.
Your performance is saved as an audio file to the root
directory of the USB storage device.
Completing the save operation calls up the Audio Play
display.

- .- ——
( Confirmation W

Save fudio Bec file ¥

Mo ¥ [ERIT] Yes ¥ [EHTER]

ENTER

Audio Play

PRESS [ENTER] TO PLAY.

Recording/Playing Back with a USB Storage Device (Audio Record/Play Mode)

Playing back the recording

Now that you've recorded the audio of your keyboard
performance, try playing back the file.

1 From the Audio Play display, select the
desired file by moving the cursor using the
Cursor [A)[V] buttons.

The audio files you record are named in numeric order
(“000.wav,” “001.wav,” etc.).

Sudio Play

PRESS [ENTER] TO PLAY.

2 Press the [ENTER] button.
The audio file will begin playing.

3 Adjust the volume via the data dial or [DECY/
[INC] buttons.

tudio Play 1
b'-I'-EIEI HEAE . way o
2 =
0o:0s # 00:36 —
855
PRESS [EANTER] TO STOP.

4 Press the [ENTER] button to stop playback.
Pressing the [ENTER] button again starts playback from that
point.

5 Press the [EXIT] button to go back to the file
select display.

6 If you want to record additional
performances, hold the [SHIFT] button then
press the [AUDIO REC/PLAY] button.
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Using a Connected Computer

By connecting this instrument to a computer, you can take advantage of the following functions and applications.
e External tone generator for DAW software and MIDI keyboard

e Remote Controller of the DAW software

¢ More detailed Voice Editing from the computer (S90 XS/S70 XS Editor)

Con necting to acom puter 3 Make sure that the USB TO HOST terminal of

this instrument is enabled.

The USB cable and USB-MIDI Driver are necessary to Press the [UTILITY] button to call up the Utility mode, select
connect the S90 XS/S70 XS to the computer. Follow the “MIDI” via the Cursor button then press the [ENTER] button
instructions below. Note that the MIDI data can be to call up the MIDI display. Set the MIDI In/Out parameter to
transmitted through a USB cable. “‘UsB.”
NOTE Since the S90 XS/S70 XS has no built-in speakers, you'll need an
external audio system or a set of stereo headphones to properly r - I Jtility MIDI 173 -"I
monitor it. For details, refer to “Setting Up” on page 16. Local Control an
Kevboard Transmit Ch 1
1 Download the USB-MIDI Driver from our
i MIDT Sunc auto
website. Clock Out on
After clicking the Download button, extract the compressed
file.
http://www.global.yamaha.com/download/usb_midi/ 4 press the [STORE] button to store this
setting.

NOTE Information on system requirements is also available at the
above web site.

NOTE The USB-MIDI Driver may be revised and updated without
prior notice. Make sure to check and download the latest
version from the above site.

2 Install the USB-MIDI Driver to the computer.
For instructions on installing, refer to the online Installation
Guide included in the downloaded file package.

When connecting this instrument to a computer in the
Installation procedure, connect the USB cable to the USB
TO HOST of this instrument and the USB terminal of the
computer as shown below.

USB terminal USB TO HOST terminal

LCD
CONTRAST Tl sT TO DEVICE

Rear panel

USB cable
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Using a Connected Computer

Precautions when using the USB TO HOST
terminal

You must observe the following points when connecting
the S90 XS/S70 XS to your computer via the USB TO HOST
connector.

Failure to do so can cause the instrument and/or the
computer to hang up (freeze), possibly causing corruption
or loss of data. If the computer or S90 XS/S70 XS freezes,
turn the power to the S90 XS/S70 XS off and then on, then
restart the computer.

e Before connecting the computer to the USB TO HOST
terminal, exit from any power-saving mode of the
computer (such as suspended, sleep, standby).

e Before turning on the power to the instrument, connect
the computer to the USB TO HOST connector.

e Execute the following before turning the power to the
instrument on/off or plugging/unplugging the USB cable
to/from the USB connector.

e Quit any open applications (such as S90 XS/S70 XS
Editor and sequencer software).

e Make sure that data is not being transmitted from the
instrument. (Data is transmitted only by playing notes
on the keyboard or playing back a song.)

* Leave an interval of at least six seconds between
powering the S90 XS/S70 XS on and off, or between
disconnecting and connecting the USB cable.

MIDI channels and MIDI ports

MIDI data is assigned to one of sixteen channels, and this
synthesizer is capable of simultaneously playing sixteen
separate Parts, via the sixteen MIDI channels. However,
the sixteen-channel limit can be overcome by using
separate MIDI “ports,” each supporting sixteen channels.
While a single MIDI cable is equipped to handle data over
up to sixteen channels simultaneously, a USB connection
is capable of handling far more—thanks to the use of MIDI
ports. Each MIDI port can handle sixteen channels, and
the USB connection allows up to eight ports, letting you
use up to 128 channels (8 ports x 16 channels) on your
computer. When connecting this instrument to a computer
using a USB cable, the MIDI ports are defined as follows:

H Port 1

The tone generator block in this instrument can recognize
and use only this port. When playing the S90 XS/S70 XS as
a tone generator from the external MIDI instrument or
computer, you should set the MIDI Port to 1 on the
connected MIDI device or computer.

H Port 2

This port is used to control the DAW software on the
computer from the S90 XS/S70 XS by using the Remote
Control feature.

H Port 3

This port is used as the MIDI Thru Port.

The MIDI data received over Port 3 via the USB TO HOST
terminal will be re-transmitted to an external MIDI device
via the MIDI OUT terminal. The MIDI data received over
Port 3 via the MIDI IN terminal will be re-transmitted to an
external device (computer, etc.) via the USB TO HOST
terminal.

H Port 4

This port is used only for data communication of the S90
XS/S70 XS Editor. No other software or device can use this
port.

H Port 5

This port is used only for data communication of the S90
XS/S70 XS Remote Editor. No other software or device can
use this port.

When using a USB connection, make sure to match the
MIDI transmit port and the MIDI receive port as well as the
MIDI transmit channel and the MIDI receive channel. Make
sure to set the MIDI port of the external device connected
to this instrument according to the above information.
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Using a Connected Computer

Using as a multi-timbral
tone generator (Multi mode)

The instructions below show how to use this instrument
as a MIDI tone generator. In this case, actual MIDI
sequence data is transmitted from a DAW or sequencer
on the computer, allowing you to avoid using software
synths and save processing power on your computer.

Setting up the S90 XS/S70 XS

1 Press the [MULTI/SEQ PLAY] button to enter
the Multi mode.

2 Select a Multi to be edited.

3 Press the [MIXING] button to call up the
Mixing display.

4 set up the Mixing for parts 1 — 16 as
necessary.
From the Mixing display, you can select the Voice and set
various parameters such as pan, volume, balance between
the chorus/reverb and dry sound, insertion effect on/off and
arpeggio on/off. For more detailed editing of the Voices, use
the Multi Part Edit display.

Setting up the DAW of the computer

1 Set the MIDI output port of the tracks (for
playing via the tone generator of the S90 XS/
S70 XS) to USB Port 1.

When connecting via USB, enter the checkmark to “Yamaha
$90 XS (S70 XS)-1” or “Yamaha S90 XS (S70 XS) Port1.”

2 Enter the MIDI data to each track of the DAW
on the computer.
The tone generator settings of the part corresponding to the
MIDI track will be set in the Mixing mode on the S90 XS/S70
XS.

NOTE By using the S90 XS/S70 XS Editor, you can create your
original Mixing setup of the S90 XS/S70 XS from your
computer. The created Mixing setup can be saved as a file
for future recall.

m S90 XS/S70 XS Owner’s Manual

Remote-controlling the
software (Remote mode)

The S90 XS/S70 XS features a highly convenient Remote
mode which lets you control the DAW software and
software synthesizer on your computer via the panel
operations of the S90 XS/S70 XS. For example, you can
start/stop playback of the DAW software on the computer
by using the Function buttons and control the song
position on the DAW software by using the data dial,
[INC] and [DEC] buttons instead of using the mouse or
keyboard of the computer.
The DAW applications Cubase, Logic Pro, SONAR and
Digital Performer can be controlled by the Remote
Control mode of the S90 XS/S70 XS. Up to 50 Control
Templates of the VST Instruments can be stored on the
internal memory of this instrument. Use the S90 XS/S70
XS Remote Editor for editing the Control Template.
NOTE The S90 XS/S70 XS Remote Editor is installed by installing the
S90 XS/S70 XS Remote Tools. The S90 XS/S70 XS Remote Tools
consists of two components: S90 XS/S70 XS Remote Editor and

S90 XS/S70 XS Extension, which enables you to use the S90 XS/
S70 XS along with Cubase series 4.5 or later.

S90 XS/S70 XS Remote Tools can be downloaded from
Yamaha web site:
http://www.yamahasynth.com/download/

Here explains how to control the DAW software from the
S90 XS/S70 XS.

Computer software that can be
controlled from the S90 XS/S70 XS

Cubase, SONAR, Logic Pro, Digital Performer

For the most recent information, refer to the following URL:
http://www.yamahasynth.com/




Setting up for Remote Control

NOTE Before making the setup of DAW Remote, make sure to install
the USB-MIDI Driver and the S90 XS/S70 XS Remote Tools
correctly.

Setting up the S90 XS/S70 XS

1 Connect this instrument to the computer via
a USB cable (page 36).

2 Press the [DAW REMOTE] button to enter the
Remote mode.

3 Press the [UTILITY] button to call up the
Remote display of the Utility mode.

Utility Remote

knb ¢ Sldr Dise Time
Enob Curwe

Slider Mode

Froa Change Mode
Velocity Meter

4 set the “DAW Select” to the desired DAW.

5 Press the [STORE] button to store this
setting.

6 start the DAW software on the computer
connected to this instrument.

Setting up the DAW of the computer

This section explains how to set up after starting each
application.

NOTE When the cable between the S90 XS/S70 XS and the Windows
computer is disconnected or the S90 XS/S70 XS is turned off
accidentally, the DAW will not recognize the S90 XS/S70 XS
again even if you connect the cable again or turn the S90 XS/S70
XS on. If this occurs, exit the DAW software, then restart it after
setting up the S90 XS/S70 XS and making sure the connection is
secure.

Cubase
The settings will be completed by installing S90 XS/S70
XS Remote Tools.

Using a Connected Computer

SONAR

1 Pull down the [Options] menu and select [MIDI
Devices] to call up the “MIDI Devices” window.

2 Add “Yamaha S90 XS (S70 XS)-2” to the Input Device,
then add “Yamaha S90 XS (S70 XS)-2” to the Output
Device.

3 Pull down the [Options] menu and select [Control
Surfaces] to call up the Control Surface window.

4 ciick the [+] button, select “Mackie Control,” then set
the Input Port to “Yamaha S90 XS (S70 XS)-2” and set
the Output Port to “Yamaha S90 XS (S70 XS)-2”

Digital Performer

1 In the AudioMIDI setup of a Macintosh computer,
connect Port 2 of the interface of the S90 XS/S70 XS
to Port 2 of the tone generator. When there is only one
Port for the tone generator, add the new Port, then
connect it to the interface.

Pull down the [Setup] menu and select [Control
Surfaces] to call up the Control Surface window.

Click the [+] button.

Select “Mackie Control” in the Driver section.

gl A~ W N

In the box for setting “Unit” and “MIDI,” select “Mackie
Control” in the “Unit” section and select “S90 XS (S70
XS) New Port 2” in the “MIDI” section.

Logic Pro

1 Select the [Preference] menu - [Control Surfaces] >
[Settings] to call up the Settings window.

Select the [New] menu - [Install].

Select “Mackie Control” in the model, then add it as a
control surface.

Set the MIDI Output Port to “Yamaha S90 XS (S70
X8)-2”

Set the MIDI Input Port to “Yamaha S90 XS (S70 XS)-
2.”

gl A N

NOTE Mackie Control is the trademark of Mackie Designs, Inc.

NOTE For details about the button operations and functions, refer to the
separate PDF manual.
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Using a Connected Computer

Editing a Control Template

Use the S90 XS/S70 XS Remote Editor for editing the
Control Template.

The S90 XS/S70 XS Remote Editor can be downloaded
from the following URL:
http://www.yamahasynth.com/download/

refer to the PDF manual included with the software.

For instructions on using the S90 XS/S70 XS Remote Editor,
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Editing more detailed
parameters of the Voice

About the S90 XS/S70 XS Editor

The S90 XS/S70 XS Editor lets you edit Mixing setups and
Mixing Voices in the Multi mode of the S90 XS/S70 XS
from your computer, giving you even greater editing
convenience. Furthermore, the data edited on the S90
XS/S70 XS is always synchronized with the data on the
computer (590 XS/S70 XS Editor) and vice versa. This
provides a smooth, seamless interface, making it
exceptionally easy to create and edit data.

Using the S90 XS/S70 XS Editor

Using the S90 XS/S70 XS Editor on Cubase
The S90 XS/S70 XS Editor works as a VST3 plug-in
software on Cubase. In this case, you can launch the S90
XS/S70 XS Editor via the same operations as that any
other VST Instrument.

Using as a stand-alone editor

In addition, Yamaha provides a stand-alone version of the
S90 XS/S70 XS Editor which works as a client of the host
Studio Manager. Studio Manager V2 is a cross-platform
application that enables you to start multiple Editors for
controlling Yamaha hardware products remotely, and lets
you save multiple Editor settings. To use the S90 XS/S70
XS Editor, start Studio Manager V2 then start the S90 XS/
S70 XS Editor as a plug-in software within Studio
Manager V2.

The Studio Manager V2 and S90 XS/S70 XS Editor can be
downloaded from the following URL:
http://www.yamahasynth.com/download/

For instructions on using the Studio Manager and S90 XS/
S70 XS Editor, refer to the respective PDF manuals
included with the software.




Playing the Keyboard Along with Playback of the MIDI File

The Multi mode/Sequence Play mode should be used when you want to play the keyboard along with playback of the
MIDI file. This instrument is equipped with a 16-track sequencer for playback, allowing you to play back MIDI data of up

to 16 tracks.

Before executing the instructions below, prepare the MIDI file (via DAW software or other means) then save it to a USB
storage device. You should also create an appropriate Multi for playback.

1 Connect the USB storage device including
the MIDI files to the USB TO DEVICE terminal
on the rear panel of this instrument.

2 Press the [MULTI/SEQ PLAY] button a few
times to enter the Sequence Play mode.

Eﬂim PRESS CENTER] TO ADD FILE.

BEZ -------- skip ---------
B3 -------- skip ---------
BEd -------- skip ---------
BES -------- skip ---------
BHs  -------- skip ---------

3 Select the Chain Step 001 then select the
desired Multi for playback of the MIDI file by
using the data dial and the [DEC]/[INC]
buttons.

B, Fress centern 1o moo Fried
; multi 661 S

;] SRS ST RS
BE2  -------- skip ---------
e e Al SkIR, s it
Bd  -------- skip -=--=-----
BEy  -------- skip ---------
gEg  -------- skipES ST e

4 Move the cursor to Chain Step 002 by using
the cursor buttons then press the [ENTER]
button.

The File Load display appears.

PRESS CENTER] TO AOD FILE.E

5 Select the USB storage device path (“usb1-1”
in this example) then press the [ENTER]

button.
[_File Load ]
[ File Load 7

PRESS [ENTEFR].

6 Select the desired MIDI file then press the
[ENTER] button.

1 Pressthe [ENTER] button after the display for
selecting the Sequence Chain Step number is
shown.

[ File Load |
B =S _sVExs . mid

Seq Chain Stee Mo [EEE
-------- skip ---------

PRESS [ENTER] TO LOAD.

8 Press the [ENTER] button again after the
confirmation display is shown.
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Playing the Keyboard Along with Playback of the MIDI File

9 Press the [EXIT] button a number of times to
go back to the Sequence Play mode.

Eﬂim PRESS CENTER] TO ADD FILE.E

Audio file selection can be done via the same operation.

10 Move the cursor to the Chain Step 003 by
using the cursor buttons then select “end”
by using the data dial and [DEC]/[INC]
button.

Eﬂim PRESs tenTerl 1o Aoo FiLe.E
BE1 multi D881 S9ERSFSTYEHS M
RS t 5 .

[

11 Select the Part for your keyboard
performance by pressing one of the [1] -
[16] buttons.

12 Move the cursor to Chain Step 001 by using
the cursor buttons then press the [START/
STOP] button to start playback.

The Multi setup recorded to Step 001 will be called up
then the MIDI file will be started.

13 Play the keyboard.
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Using as a Master Keyboard (Master Mode)

The Master mode lets you:

e Create and store up to 128 programs, each containing a Voice, a Performance or a Multi, and of which can be instantly

called up for use.

e Assign up to four separate Zones in each Master program for use as a master keyboard.

You can use the Master mode to memorize the settings you use most often including the information on which mode is
used, and call up these settings instantly anytime you need them with a single button press. Furthermore, you can
memorize the settings for controlling an external MIDI device by the Master, allowing you to change and control the
connected external MIDI tone generator in sequence while performing live.

Storing the Edited Voice/
Performance/Multi

It is a good idea to assign the Voice mode to one Master
program number (for example, 001) and the Performance
mode to the next numbered program (i.e., 002) if you
want to quickly call up a specific Voice then a related
specific Performance. Follow the steps below to store the
program.

1 Press the [MASTER] button to enter the
Master mode.

2 Select a Master to be edited.
The Master Play display appears.

3 Press the [EDIT] button.
The Master Edit Select display appears.

Edit Select a

Common |

[Zane 1] [ZoneZ] [Fone?] [Eoned]

PRESS [ENTERI.

4 select “Common” then press the [ENTER]
button.
The Common Edit display appears.

commonEdit Select E|

[Fane ] WEEESTM) [Zone v

PRESS [ENTERI.

5 select “Memory” by using the cursor buttons
then press the [ENTER] button.
The Common Memory display appears.

common Memary

Bank
Humber

FEE1
B25
CP78 Chorus

6 At the “Mode” parameter, select “voice,’
“performance” or “multi.”

1 Select the desired program by setting the
Bank and Number.

8 Press the [STORE] button to execute the
Store operation.

Making settings for use as
a master keyboard

It is a good idea to memorize the master keyboard
function to the Master when using external multiple MIDI
tone generators. Simply by selecting a different Master,
you can change the programs in your connected external
MIDI tone generators. Here's how to do it:

1 Press the [MASTER] button to enter the
Master mode.

2 Select a Master to be edited.
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Using as a Master Keyboard (Master Mode)

3 Press the [EDIT] button. 8 select “Zone 17 by using the cursor buttons
The Master Edit Select display appears. then press the [ENTER] button.
The Zone Edit Select display appears.

MASTER Edit Select E

PR ok 20N Edit Select  2mme 13

Comman |
[Eone1] [EoneZ] [EoneZ] [Zoned] EENN [ Hote | [Preset |
Enb Sidr

PRESS [ENTEFR].

PRESS [ENTERI.

4 select “Common” then press the [ENTER]

button. 9 Make the settings of the Zone 1 in the
The Common Edit display appears. respective Transmit, Note, Preset and Knb/
Sidr displays.

ARy el COMMONEdit Select E
(EE [Zone Su ] RSTER SR Ll

s B

[mln] " iy T

PRESS [ENTER]. Faoof CErl 2 i -

5 Select “Zone Sw” then press the [ENTER] Transmit display
button.

MASTER "l g EI:II'IE1E

The Common Zone Switch display appears.

MAS TER WML =T

knob ¢ Slider S

6 set “Zone Switch” to “on.”
The “Knob/Slider” parameter also will be set to on e
automatically. MIDISendSw |
Preset display

R NSl COMMON Zone Sw E

MASTER el A Ta=i [ EIJHE1E

18] 1@ 1@
Slider @y a7 av a7

kEnob /¢ Slider on

NOTE When using the Knobs/Sliders as the controller of the Knob

Function/Slider Function, set the Knob/Slider to off. Knob/Slider display

10 Press the [EXIT] button to return back to the
Master Edit Select display, then set the
other Zone using this same operation.

1 Press the [EXIT] button twice to return to the
Master Edit Select display.

A4S TER Edit Select
——— B 11 Atter setting all the desired parameters,

_ Common | press the [STORE] button to store your
Eane 1] ZoneZ] [Fone] [Zoned] settings as a Master program.

PRESS [ENTERI.

After completing these settings, assign a name to the
Master in the “Name” parameter of the Master Common
Edit display. After naming, press the [STORE] button to
store the Master.
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Making Global System Settings (Utility Mode)

In the Utility mode, you can set parameters that apply to the entire system of this instrument. To enter the Utility mode,
press the [UTILITY] button. Pressing the [EXIT] button returns to the original display.
This section describes some useful functions in the Utility mode.

Setting the default mode when turning
the power on

General > Power on Mode
From the Voice, Performance, Multi and Master, the mode
specified here is called up when turning the power on.

[[#Utility General 4/5
duto Load

Reversing the LCD status

General > LCD Mode

This parameter determines the LCD status.

ETEE, FRE 1:861 (A81)

Categary: Pjano <A pno:

Matural Grand $6
"ns § oo § rev QN men |

When “normal” is selected:

Categaory: Piano <A poo: 4 o0

Matural Grand $6

When “reverse” is selected:

Click (metronome) settings

General - Click Sw — OutputSel
Determines the tempo, volume and output destination of
the click (metronome).

= Utility General 5/

Beat did
Tempo Q6
Molume 188
Tupe 1
OutputSel L&R

Micro Tuning

MicroTune
Tunes the individual notes of the keyboard.

[ Utility Select
[ General [ HMIDI |[Contraller]

LGN VYoice |[ Remote |

[Guick Set][Fanel Lock] [Fotry Set]

PRESS CENTERI.

Effect settings applied to the signal
input from the MIC INPUT jack

Voice - A/D FX

Determines the Effect settings and Vocoder settings
applied to the signal input from the MIC INPUT jack in the
Voice Mode.

Utilits Yoice A7D Effect ﬂ
Tupa © Thiru

PRFGE TFNTFR1

NOTE For details on how to apply the Insertion Effect, refer to page 24.

Master Effect/Master EQ settings in the
Voice mode

Voice = Master FX, Master EQ
Determines how much of the Effect and EQ processing is
applied to the master output.

Ltility Yoice Select

Arpeagio|[ A/D Out [ ADFX |
|I'.'Iaster' EIR|

PRESS CENTERI.
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Making Global System Settings (Utility Mode)

Changing the panel lock settings

Panel Lock

Determines the buttons which are “locked” or become
unavailable when pressing the [PANEL LOCK] button on
the panel. When the check mark is removed from the
check box, the corresponding button is available even if
Panel Lock is turned on.

Utility Panel Lock

E all

— Transpose
— Humber 1-1&

Quick Setup

Quick Set

This lets you call up the parameter settings about the
external connection in the Performance mode/Multi mode
simply by selecting the one from the Preset. It is
convenient since the parameters in various displays are
set to the appropriate values simply by selecting the
Quick Set number. The initial settings and description of
each Quick Setup number is as follows:

Quick Setup Description
number

1 When recording performance data other than
Arpeggio data to a DAW software on a computer.

2 When recording performance data including
Arpeggio data to a DAW software on a computer.

3 When using the S90 XS/S70 XS as a stand-alone
device, without connecting to a DAW software or
other MIDI devices.

[ Utility Select
[ General [ MIDI |[Controller]

[MictoTune|[ Moice |[ Remote |
= S| (P anel Lock| [Fotiy Set|
PRESS [ENTERI.
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Saving/Loading Data (File Mode)

In the File mode, you can save/load the data such as Voice and Performance created on this instrument. To enter the File
mode, press the [FILE] button.
This section explains how to save/load all the data on the user memory of this instrument as an “All” file (extension: X2A).

Saving the Settings to a 9 Select the desired directory then press the
h [ENTER] button.
USB storage deV|ce To save the file to the directory, move the cursor to “NEW

FILE” then press the [ENTER] button. The display for
selecting the file type is shown.

1 Connecta USB storage device to the USB TO
DEVICE terminal of this instrument.

[_File Save ]

2 Press the [FILE] button to enter the File
mode. File Tere RGN

The File Select display appears.
PRESS [ENTER] TO SALE.

[ File Select N

6 Select the File type then press the [ENTER]
) [ cd | button.

Select “All” if you want to save all the data. When the data

PRESS [ENTERL saved via “All” is loaded back to the instrument, you can still

select specific data you wish to retrieve—such as specific
Voices or specific Voice Banks—as well as all of the data.

3 Sselect “Save” by using the cursor buttons

then press the [ENTER] button. 7 Assign a name to the file then press the
The internal flash memory and USB storage device are [ENTER] button.
shown on the File Save display. Select the desired characters by using the data dial and

cursor buttons then press the [INC] button to enter the
selected character. To cancel the selected character, press
the [DEC] button.

File Save

M1 23456759 _ 1540 CLERR
AECDEFGHI JELMHOPQRESTUVINEY S
abcdefshidk I mnorars tuwwxaz
- P CE R N R Ay |
PRESS [ENTER] TO EXEE.

4 select the USB storage device by using the
Cursor [A]/[V] buttons then press the

[ENTER] button.
The root directory of the USB storage device is shown. 8 Press the [ENTER] button again after the

confirmation display is shown.
This actually saves the file.

File Sawve

File Sawe

O S9ERE . Kb
PFRESS [ENTER].

PRESS [ENTEF].
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Saving/Loading Data (File Mode)

Loading the settings from a
USB storage device

1 ConnectaUusB storage device to the USB TO
DEVICE terminal of this instrument.

2 Press the [FILE] button to enter the File mode.
The File Select display appears.

[ File Select N

WEEE) [ Coad |

PRESS [ENTERI.

3 Select “Load” by using the cursor buttons
then press the [ENTER] button.
The internal flash memory and USB storage device are
shown on the File Load display.

File Load

u=bi-1

4 select the USB storage device by using the
Cursor [A]/[V] buttons then press the
[ENTER] button.

The root directory of the USB storage device is shown.

[ File Laad N

PRESS CENTEFR].

If there is a folder or directory in the USB storage device,
move the path by using the Cursor [P ] button.

5 Select “X2A” as the extension then press the
[ENTER] button.
The loadable data types are shown and one of them can be
selected.

File Load
H-88

-Gl | | owi thout sastem
nksgello i ce
@ =9Per formance

Al Arpesgio

PRESS [ENTER] TO LOAD.
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6 Select the desired data type then press the

[ENTER] button.

To load all the Voices or Performances to all the internal User
Banks, select “Voice” or “Performance” then press the
[ENTER] button. To load a specific Voice Bank or
Performance Bank, select “Voice” or “Performance,” press
the Cursor [P ] button, select the desired Bank, and then
press the [ENTER] button.

Press the [ENTER] button again after the
confirmation display is shown.



USB storage devices

Connection Examples

USB storage device such as
hard disk drive

USB flash memory |;| or 5 USB TO DEVICE terminal

© ooog,, 0099 .
o s Qo s o s

oo

S90 XS/S70 XS

Compatible USB devices
Connect only a USB storage device (such as hard disk,
CD-ROM, flash memory and other drives) to the USB TO
DEVICE connector. Other USB devices such as a
computer keyboard or mouse cannot be used. Both bus-
powered (powered by the host device) or self-powered
(battery or external power supply) types can be used.
Before purchasing USB storage devices, please consult
your Yamaha dealer, or an authorized Yamaha distributor
(see list at end of the Owner’s Manual) for advice, or see
the following web page:
http://www.yamahasynth.com/
NOTE Although CD-R/RW drives can be used to load data to the
instrument, they cannot be used for saving data. However, you

can transfer the data to a computer and save it to a CD using the
CD-R/RW drive on the computer.

Formatting USB storage media

When an unformatted USB storage device is connected
to the USB TO DEVICE connector or when unformatted
media is inserted to the USB device connected to the
USB TO DEVICE connector, the indication “unformatted
device (usb***)” is shown in the device list on the Save/
Load display of the File mode. If this happens, execute
the Format operation in the File Job display.

NOTE The three asterisks (***) in the example indication above denote
the sequential serial numbers of the connected devices which
need to be formatted. When several partitions are included in a
single device, the partition number is indicated at the right of the
serial number.

Precautions when using the USB TO
DEVICE terminal

Please keep in mind the following points:

A CAUTION

Never turn the USB device’s power on/off and never plug/
unplug the USB cable when the connected USB storage device
is the self-powered type. Doing so may result in the operation
of the synthesizer “freezing” or hanging up. While the
instrument is accessing data (such as in the Save, Load and
Delete operations in the File mode), do NOT unplug the USB
cable, do NOT remove the media from the device, and do NOT
turn the power off to either device. Doing so may corrupt the
data on either or both devices.

Saving/Loading Data (File Mode)
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Appendix

Display Messages

LCD Indication

Description

All data is initialized upon power-on.
Continue?

Confirms whether you want to turn on the “Power on auto factory set switch” parameter or not.

Are you sure?

Confirms whether you want to execute a specified operation or not.

Assign Vocoder Voice to Part 1.
Continue?

Confirms whether you want to select a Vocoder Voice via the Category Search display when setting
the Output Select of the A/D Input part to “Vocoder” when Part 1 is not a Vocoder Voice in the
Performance/Multi mode.

Assign Vocoder Voice. Continue?

Confirms whether you want to select a Vocoder Voice via the Category Search display when setting
the Output Select of the A/D Input part to “Vocoder” when the Voice is not a Vocoder Voice in the Voice
mode.

Audio Rec stopped due to lack of memory
space.

This message appears when memory space has run out and audio recording has been stopped.

Bad disk or memory.

The external storage device connected to this synthesizer is unusable. Format the external storage
device and try again.

Bulk data protected.

Bulk Data cannot be received because of the setting in the Utility mode.

Can't execute.

The synthesizer cannot execute because of the settings or situations.

Click off. The Click (metronome) has been turned off.
Click on. The Click (metronome) has been turned on.
Completed. The specified load, save, format, or other Job has been completed.

Connecting to USB device...

Recognizing the USB storage device connected to the USB TO DEVICE terminal.

Copied Arpeggio type.

Copied Arpeggio type.

Device number is off.

Bulk data cannot be transmitted/received since the device number is off.

Device number mismatch.

Bulk data cannot be transmitted/received since the device numbers don't match.

Directory is not empty.

You have attempted to delete a folder that contains data.

Disk or memory is full.

The external storage device is full and no more data can be saved. Use a new external storage
device, or make space by erasing unwanted data from the storage device.

Disk or memory is write-protected.

The external storage device is write protected, or you have attempted to write to a read-only medium
such as CD-ROM.

Disk or memory read/write error.

An error occurred while reading or writing to/from an external storage device.

Executing...

Executing the processing.

Executing... ***.wav

This message appears when creating a audio file via Audio Record function.
“***"is the name of the file.

Executing...
Please keep power on.

This message appears when processing with writing to the internal memory. Please keep power on
while this message is shown.

File already exists.

A file having the same name as the one you are about to save already exists.

File is not found.

The specified file was not found on the external storage device during a load operation.

File path is too long.

The file or directory you tried to access cannot be accessed because the amount of characters
indicating the path is too long.

lllegal bulk data.

An error occurred while receiving the Bulk data or Bulk Request message.

lllegal file name.

The specified file name is invalid. Try entering a different name.

lllegal file.

The file specified for loading is unusable by this synthesizer or cannot be loaded in the current mode.

Learning...

This message appears when learning a parameter to the Knob/Slider in the Remote mode.

Load All Arpeggios. Are you sure?

Confirms whether you want to load the “All Arpeggio” or not in the File mode.

Load All Performances. Are you sure?

Confirms whether you want to load the “All Performances” or not in the File mode.

Load All Voices. Are you sure?

Confirms whether you want to load the “All Voices” or not in the File mode.

Load All without system. Are you sure?

Confirms whether you want to load the “All without system” or not in the File mode.
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Display Messages

LCD Indication

Description

Load All. Are you sure?

Confirms whether you want to load the “All” or not in the File mode.

Load Seq Chain file. Are you sure?

Confirms whether you want to load the “Seq Chain file” or not in the File mode.

MIDI buffer full.

Failed to process the MIDI data because too much data was received at one time.

MIDI checksum error.

An error occurred when receiving bulk data.

Mixing Voice full.

The Mixing Voice cannot be stored because the number of Voices already stored has exceeded the
maximum capacity.

No read/write authority to the file.

No permission for reading/writing on the external storage device.

Now executing Factory set...
Please keep power on.

Indicates this synthesizer is restoring the factory-programmed settings.

Now loading...

Indicates that a file is being loaded.

Now receiving MIDI bulk data...

Indicates this synthesizer is receiving MIDI bulk data.

Now saving...

Indicates that a file is being saved.

Now scanning autoload file...

Scanning for the files specified for Auto Load.

Now transmitting MIDI bulk data...

Indicates this synthesizer is transmitting MIDI bulk data.

Overwrite. Are you sure?

A save operation will overwrite data on the external storage device as destination, and this message
confirms whether it is OK to continue or not. Press [ENTER] (Yes) or [EXIT] (No) as required.

Part x is used for Drum Assign.

This message appears when the Part switches of all Parts are set to on, and the Drum Assign function
used Part “x” for the Drum Part in Performance mode.

Part x is used for Layer.

This message appears when the Part switches of all Parts are set to on, and the Layer function used
Part “x” for the Layer Part in the Performance mode.

Part x is used for Split.

This message appears when the Part switches of all Parts are set to on, and the Split function used
Part “x” for the Split Part in the Performance mode.

Please stop Audio Play/Rec.

The operation you have attempted to execute cannot be done during Audio Rec/Play recording or
playback.

Please stop sequencer.

The operation you have attempted to execute cannot be done during SEQ PLAY playback.

Save Audio Rec file?

Confirming whether you want to save the recorded file or not in Audio Rec/Play mode.

Seq Chain stored.

This message appears when the Seq Chain settings has been stored.

Sequence memory full.

The internal memory for Sequence data is full, preventing any further operation (such as recording,
editing, Job execution, MIDI reception/transmission, or loading from the external storage device).
Try again after erasing unwanted Song, Pattern, or User Phrase data.

Set Part 1 Ins Sw to on to use Vocoder.

Set the Insertion Switch of Part 1 to on to use the Vocoder when setting the Output Select of the A/D
Input part to “Vocoder.”

MIDI data overload.

The amount of MIDI data is too large to play.

Store Voice?

Confirms you want to store the editing Voice when executing the Performance Creator (Layer/Split/
Drum Assign) feature to the editing Voice in the Voice mode.

The received MIDI bulk data’s type is not
compatible with the current mode/voice
type.

This message appears when MIDI bulk data is received in a different mode other than the currently
selected mode. The bulk data is received in the same mode as the transmitting mode. This message
also appears when the Voice type (Normal Voice/Drum Voice) of the destination Mixing Parts is
different from the bulk-dump-transferred Voice type. The destination Parts assigned to the same Voice
type as the bulk-dump-transferred Voice type are selected.

This Performance uses User Voices.

The loaded Performance uses User Voices. Confirm whether the same Voices as at the time of saving
are stored at the same User Bank/Number or not.

USB connection terminated.
Press any button.

A break in the connection with the USB storage device has occurred because of an abnormal electric
current. Disconnect the USB storage device from the USB TO DEVICE connector, then press any of
the panel buttons.

Utility stored.

The settings in the Utility mode have been stored.
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Troubleshooting

The following table provides troubleshooting hints and page references for some common problems. You may solve your
problem by executing the Factory Set (page 18) after backing up your data to an external storage device. If the problem
persists, then contact your Yamaha dealer or service center (page 63).

No Sound

Is the S90 XS/S70 XS properly connected to related external equipment (e.g., amplifier, speaker, headphone)
via audio cables?

Since the S90 XS/S70 XS has no built-in speakers, You will need an external audio system or a set of stereo headphones to properly
monitor it.

Is the power of this synthesizer and any external equipment connected to this synthesizer turned on?

Have you made all the appropriate level settings—including the Master Volume on this synthesizer and the
volume settings on any connected external equipment?
Is the Foot Controller pressed down (when it is connected to the FOOT CONTROLLER jack)?

Are all four Sliders set to appropriate levels (other than zero or minimum)?
Is the Local Control set to OFF?
If this is set to off, the internal tone generator will not sound.

[UTILITY] = MIDI - Local Control

Are the MIDI volume or MIDI expression settings too low when using the external controller?
Are the effect and filter settings appropriate?
If you are using the filter, try changing the cutoff frequency. Some cutoff settings may filter out all of the sound.
[VOICE] > [EDIT] > Effect
[VOICE] > [EDIT] -> Filter/EG
[PERFORM] - [EDIT] > Common -> Effect
[PERFORM] - [EDIT] > Common -> Filter/EG
[PERFORM] > [EDIT] > Part selection -> Filter/EG
[MULTI/SEQ PLAY] (selecting Multi mode) - [EDIT] > Common -> Effect
[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] - Part selection > Filter/EG

Is “Vocoder” selected as the Insertion Effect Type of the Voice?

If so, set the parameters related to the AD Input Part and MIC INPUT connector to the appropriate values then play the keyboard
while inputting your voice into the microphone connected to the S90 XS/S70 XS. Check whether or not the INPUT GAIN knob on the
panel is set to the minimum position.

[VOICE] - [EDIT] > Effect > Ins Connect Type: vocoder
[UTILITY] = [VOICE] > A/D Out - Output Select: vocoder

Are the volume or expression settings too low?
[UTILITY] = General - Volume
[VOICE] - [EDIT] = Play Mode > Volume
[VOICE] - [EDIT] -> Easy Element Edit mode via the Slider Function button > Sliders
[PERFORM] > [EDIT] > Common -> Play Mode - Volume
[PERFORM] - [EDIT] - Part selection > Play Mode - Volume
[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] -> Part selection > Play Mode - Volume
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Troubleshooting

Are the parameter settings such as Element Switch, Part Switch, Note Limit and Velocity Limit appropriate?
[VOICE] > [EDIT] & [MUTE] (lighting) > Number [9] — [16] buttons
[PERFORM] = [PART ON/OFF]
[PERFORM] > [EDIT] > Part selection - Play Mode - Note Limit Lo/Hi
[PERFORM] - [EDIT] - Part selection > Play Mode > Velocity Limit Lo/Hi

When the Performance/Multi produces no sound, has a Voice been assigned to each Part?
[PERFORM] > [EDIT] > Part selection - Voice
[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] -> Part selection -> Voice

When the Performance/Multi produces no sound, is the output setting of each Part set appropriately?
[PERFORM] - [EDIT] = Part selection - Play Mode > Output Select
[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] - Part selection > Play Mode - Output Select

When the Multi produces no sound, are the output port/channel of each track in the external sequencer and
the receive channel of each Part in the Multi set appropriately?

[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] - Part selection > Voice - Receive Ch

When the Performance/Multi produces no sound, is the “Arpeggio Play Only” parameter of each Part turned
on?

[PERFORM] - [EDIT] - Part selection > Voice = Arp Play Only

[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] - Part selection -> Voice > Arp Play Only

No sound from the MIC INPUT jack

Is the microphone switch turned on?

Is the cable between the microphone and the synthesizer properly connected?
Is the [MIC ON/OFF] button set to on (lamp is lit)?

Is the INPUT GAIN knob turned fully counter-clockwise (to the minimum)?

Are the volume settings of the A/D Input Part too low?

Selecting “MIC” via the Knob Function button - VOLUME knob

Are the effect settings appropriate?
[UTILITY] = Voice > A/D FX
[PERFORM] > [EDIT] & Common > A/D FX
[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] > Common > A/D FX

Is the output setting of the A/D Input Part set appropriately?
[UTILITY] = Voice - A/D Out > Output Select
[PERFORM] - [EDIT] > Common > A/D Out - Output Select
[MULTI/SEQ PLAY] (selecting Multi mode) - [EDIT] > Common -> A/D Out > Output Select

Split does not work via the external MIDI device

The settings of the “Split Sw” parameter and “Split Lower/Upper” parameter in the Performance mode work
only when playing the keyboard of the instrument itself.
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Troubleshooting

Playback continues without stopping

B When the [ARP ON/OFF] button is turned on, press it so that its lamp is turned off.
B In Sequence Play Mode, press the [START/STOP] button.

B When the click (metronome) sound continues, hold down the [SHIFT] button and press the [START/STOP]
button to stop the sound.

The sound is distorted

B Are the effect settings appropriate?
Use of an effect at certain settings may produce distortion.

[VOICE] > [EDIT] - Effect
[PERFORM] - [EDIT] > Common > Effect
[MULTI/SEQ PLAY] (selecting Multi mode) - [EDIT] > Common -> Effect

Use of the Master Effect at certain settings may produce distortion.
[UTILITY] = Voice > Master FX
[PERFORM] - [EDIT] > Common > Effect > Master
[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] > Common -> Effect > Master

W Are the filter settings appropriate?
Excessively high filter resonance settings can cause distortion.

[VOICE] > [EDIT] -> Filter/EG

[PERFORM] > [EDIT] - Common > Filter/EG

[PERFORM] - [EDIT] - Part selection > Filtet/EG

[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] - Part selection > Filter/EG

B Are any of the following volume parameters set so high that clipping is occurring?
[UTILITY] > General > Volume
[UTILITY] > General &> L&R Gain
[VOICE] - [EDIT] - Play Mode - Volume
[PERFORM] > [EDIT] > Common - Play Mode - Volume
[PERFORM] - [EDIT] - Part selection > Play Mode - Volume
[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] - Part selection > Play Mode - Volume

Sound is cut off

B s the entire sound (via your keyboard playback and Sequence playback) exceeding the maximum polyphony
of the synthesizer?

Only one note sounds at a time

B When this situation occurs, the Mono/Poly parameter in the current mode is set to “mono.”
If you wish to play chords, set this parameter to “poly.”

[VOICE] > [EDIT] - Play Mode > Mono/Poly
[PERFORM] -> [EDIT] - Part selection > Play Mode > Mono/Poly
[MULTI/SEQ PLAY] (selecting Multi mode) = [EDIT] - Part selection - Play Mode - Mono/Poly

S90 XS/S70 XS Owner’s Manual



Troubleshooting

Wrong pitch or unexpected pitch

H Is the Tune parameter in the Utility mode set to a value other than “0”?
[UTILITY] > General > Tune

B Is the Note Shift parameter in the Utility mode set to a value other than “0”?
[UTILITY] = General > Note Shift

B When the Voice produces a wrong pitch, is the appropriate tuning system selected from Micro Tune parameter
in the Voice Edit mode?

[UTILITY] > Micro Tune

B When the Performance/Multi produces a wrong pitch, is the Note Shift parameter of each Part set to a value
other than “0”?

[PERFORM] -> [EDIT] - Part selection > Play Mode
[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] - Part selection > Play Mode

No effect is applied

Have the REVERB and CHORUS Knobs/Sliders been turned fully to the minimum?
Have any or all of the effect types been set to “thru” or “off”?

Is the EFFECT ON/OFF parameter of each Effect set to OFF?

When this occurs in the Performance/Multi mode, check whether the Insertion Switch (Ins Effect Sw)
parameters are set properly or not.

[PERFORM] - [EDIT] = Part selection > FX Send - Ins Effect Sw
[MULTI/SEQ PLAY] (selecting Multi mode) = [EDIT] - Part selection > FX Send - Ins Effect Sw

Vocoder does not work when selecting a Vocoder Voice

B |s the output of the A/D Input Part set to “vocoder”?
[UTILITY] = Voice > A/D Out = Output Select
[PERFORM] > [EDIT] > Common > A/D Out > Output Select
[MULTI/SEQ PLAY] (selecting Multi mode) - [EDIT] > Common -> A/D Out > Output Select

The Edit Indicator appears, even when parameters are not being edited

B Keep in mind that even though the Edit mode is not active, simply moving a Knob/Slider changes the current
Voice, Performance, or Multi, causing the Edit Indicator to appear.

B Some Arpeggio types include MIDI Control Change messages. When you play back such an Arpeggio type, the
sound of the current Voice may inadvertently be changed and the Edit Indicator may appear in the top right of
the display.
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Troubleshooting

Cannot start the Arpeggio

B Check whether the [ARP ON/OFF] button is turned on or off.

B Is the MIDI Sync parameter set to auto or internal (using internal clock)?
[UTILITY] = MIDI > MIDI sync

B Have you selected a User Arpeggio type (with no User Data)?
To use the User Arpeggios, the User Arpeggio data created in the MOTIF XS must be loaded to the S90 XS/S70 XS.

B Are the Arpeggio related parameters such as Note Limit and Velocity Limit set appropriately?

[VOICE] - [EDIT] > Arpeggio - Arp Edit > Note Limit Lo/Hi

[VOICE] - [EDIT] -> Arpeggio > Arp Edit > Velocity Limit Lo/Hi

[PERFORM] > [EDIT] > Part selection - Arpeggio > Arp Edit > Note Limit Lo/Hi

[PERFORM] - [EDIT] - Part selection > Arpeggio > Arp Edit > Velocity Limit Lo/Hi

[MULTI/SEQ PLAY] (selecting Multi mode) - [EDIT] - Part selection > Arpeggio > Arp Edit > Note Limit Lo/Hi

[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] - Part selection > Arpeggio > Arp Edit > Velocity Limit Lo/Hi

B When this situation occurs in the Performance/Multi mode, check the Arpeggio Switch parameter.

[PERFORM] - [EDIT] - Part selection > Arpeggio - Arp Edit > Arp Sw
[MULTI/SEQ PLAY] (selecting Multi mode) > [EDIT] - Part selection > Arpeggio > Arp Edit > Arp Sw

Cannot stop the Arpeggio

B When Arpeggio playback does not stop even when you release the key, set the Arpeggio Hold parameter to
“off” via the [ARP HOLD] 1 - 4 buttons.

The Voice assigned to the Performance produces a different sound from the one in the
Voice mode

B This is normal because the Voice sound is determined by the parameter settings in the Performance mode. For
the Performance Parts, you will need to apply basically the same parameter settings as those used in the Voice
mode. Regarding the Effect settings except for the send level, you can copy the settings in the Voice mode to
the Performance part in the following display. By executing this Job, you can ensure that the Voice will sound
the same in the Performance mode as it does in the Voice mode.

[PERFORM] > [JOB] > Copy - Voice
[PERFORM] > [EDIT] > Part selection > FX Send

Data communication between the computer and the S90 XS/S70 XS does not work
properly

B Check whether the Port setting on the computer is appropriate or not.

B Check whether the MIDI In/Out settings of the instrument are appropriate or not.

[UTILITY] > [MIDI] > MIDI In/Out

The S90 XS/S70 XS does not sound properly even when playing back the song data
on the computer or the MIDI instrument connected to the S90 XS/S70 XS

B |s the S90 XS/S70 XS set to the Multi mode?
Select the Multi mode to play multiple channels simultaneously.
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Troubleshooting

MIDI bulk data transmission/reception does not work properly

m Is the Receive Bulk parameter set to off?
Set the Receive Bulk parameter to on.

[UTILITY] > [MIDI] > Receive Bulk

W If the data was saved with the Bulk Dump function of the S90 XS/S70 XS, you need to set the Device Number to
the same number before Bulk Dump transmission.

[UTILITY] = [MIDI] = Device No.

B When transmission does not work properly, is the device number of the MIDI instrument connected to the S90
XS/S70 XS set to match the Device Number Parameter in the Utility mode?

[UTILITY] = [MIDI] = Device No.

Cannot save data to the external USB storage device

B Is the USB storage device being used write protected? (Write-protect should be set to off for saving data.)

B Is the USB storage device being used properly formatted?

[FILE] > Save - Selecting USB storage device > [JOB] > FORMAT

Cannot play an audio file

B Is the format of the audio file correct?
The S90 XS/S70 XS can play only stereo WAVE (.wav)/AlIFF (.aif) files at 44.1kHz/16-bit.

Cannot enter the Edit mode

B Is the S90 XS/S70 XS in the File mode?
After exiting from the File mode, press the [EDIT] button.
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Specifications

S90 XS S70 XS

Keyboard

88 keys, Balanced Hammer Effect Keyboard
(Initial Touch/Aftertouch)

76 keys, Balanced Hammer Effect Keyboard
(Initial Touch/Aftertouch)

Tone Generator

AWM2 with Expanded Articulation

Maximum polyphony

128 notes

Multi-Timbral Capacity

16 Internal Parts + Mic Input Part

Wave 456 MB (when converted to 16-bit linear format), 2,772 waveforms
Voice Preset: 1,024 normal voices + 64 drum kits
Tone Generator GM: 128 normgl voices + 1 drum kits . .
block User: 128 x 4 (Bank 1 - 3: selected and copied from Preset bank) Normal Voice + 32 drum kits
Performance User: 128 x 4 (up to 4 Parts)
Multi User: 128
Filter 18 types
Effects Reverb x 9 types, Chorus x 22 types, Insertion (A, B) x 53 types x 8 blocks,
Vocoder x 1 (uses both Insertion Effect A and B blocks), Master Effect x 9 types,
Master Equalizer (5 bands), Part EQ (3 bands, stereo)
Sequence Play SMF Format 0/1 (playback only)
BPM (Tempo) 5-300
Sequencer
Section Number of Chain Steps 100
Arpeggio Preset x 6,779 types
User x 256 types (when loading the User Arpeggio data of MOTIF XS).
Audio Rec/Play  Format Recording: WAVE (.wav/44.1kHz/16-bit/stereo)
Section Playback: WAVE (.wav/44.1kHz/16-bit/stereo), AIFF (.aif/44.1kHz/16-bit/stereo)
Master User: 128
* 4 Zones (Master keyboard settings), Assignable Knob/Slider settings, Program Change Table
Sequence Software For Windows®: Cubase 5, Cubase 4.5, SONAR 8
compatible with the For Macintosh®: Cubase 5, Cubase 4.5, Logic Pro 8, Digital Performer 6
Remote Control function * Functions to be controlled by the S90 XS/S70 XS differ depending on the software you use.
Controllers Pitch Bend wheel, Modulation wheel, Sliders (4), Knobs (4), Assignable Function button (2),
Data dial, Input Gain
Display 160 x 64 dot graphic backlit LCD
Other

Jack and Terminals

OUTPUT L/MONO, R (standard phone jack), ASSIGNABLE OUTPUT L, R (standard phone jack),
MIC INPUT (combo jack), PHONES (standard stereo phone jack), FOOT CONTROLLER 1, 2,
FOOT SWITCH x 2 (SUSTAIN, ASSIGNABLE), MIDI IN/OUT/THRU, USB (TO HOST, TO DEVICE),
AC IN

Power Consumption

25 W

Dimensions, Weight

1,472 (W) x 385 (D) x 173 (H) mm
22.4 kg

1,320 (W) x 385 (D) x 173 (H) mm
20.4 kg

Accessories

AC Power cord, Owner’s Manual (this book), Owner’'s Manual CD-ROM (containing Reference
Manual and Data List), DVD-ROM (containing DAW software)

* Specifications and descriptions in this owner’s manual are for information purposes only. Yamaha Corp. reserves the right to change or modify products or specifications at any
time without prior notice. Since specifications, equipment or options may not be the same in every locale, please check with your Yamaha dealer.

Note on source code distribution
For three years after the final factory shipment, you may request from Yamaha the source code for any portions of the product which are licensed under the GNU General Public
License by writing to the following address:

DE Group, DMI Marketing Department. PA-DMI Division, YAMAHA Corporation
10-1 Nakazawa-cho, Naka-ku, Hamamatsu, 430-8650, JAPAN
The source code will be provided at no charge; however, we may require you to reimburse Yamaha for the cost of delivering the source code to you.
* Note that we shall bear no responsibility whatsoever for any damage arising from changes (additions/ deletions) made to the software for this product by a third party other than
Yamaha (or party authorized by Yamaha).
* Note that re-use of source code released to the public domain by Yamaha is unguaranteed, and Yamaha shall not bear any responsibility whatsoever for the source code.
* The source code can be downloaded from the following address:
http://www.yamahasynth.com/download/source/s_xs
¢ About GNU General Public License, refer to the separate Data List (PDF documentation).
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ATTENTION
SOFTWARE LICENSE AGREEMENT

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (“AGREEMENT”) CAREFULLY BEFORE USING THIS SOFTWARE. YOU ARE ONLY
PERMITTED TO USE THIS SOFTWARE PURSUANT TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. THIS AGREEMENT IS BETWEEN
YOU (AS AN INDIVIDUAL OR LEGAL ENTITY) AND YAMAHA CORPORATION (“YAMAHA”).

BY BREAKING THE SEAL OF THIS PACKAGE YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE
WITH THE TERMS, DO NOT INSTALL, COPY, OR OTHERWISE USE THIS SOFTWARE.

THIS AGREEMENT PROVIDES YOUR USE-CONDITIONS ABOUT THE “DAW” SOFTWARE OF STEINBERG MEDIA TECHNOLOGIES GMBH
(“STEINBERG”) WHICH 1S BUNDLED WITH THIS PRODUCT. SINCE THE END-USER SOFTWARE LICENSE AGREEMENT (EUSLA) SHOWN ON
YOUR PC-DISPLAY IN YOUR INSTALLING THE “DAW” SOFTWARE IS REPLACED BY THIS AGREEMENT, YOU SHOULD DISREGARD THE
EUSLA. THAT IS, IN THE INSTALLING PROCESS, YOU SHOULD SELECT "AGREE” WITH THE EUSLA, WITHOUT YOUR JUDGMENT THERETO,

SO AS TO PROCEED TO THE NEXT PAGE.

1. GRANT OF LICENSE AND COPYRIGHT

Yamaha hereby grants you the right to use one copy of the software
program(s) and data (“SOFTWARE”) accompanying this Agreement.
The term SOFTWARE shall encompass any updates to the
accompanying software and data. The SOFTWARE is owned by
STEINBERG, and is protected by relevant copyright laws and all
applicable treaty provisions. Yamaha has acquired the sublicense
right to license you to use the SOFTWARE. While you are entitled to
claim ownership of the data created with the use of SOFTWARE, the
SOFTWARE will continue to be protected under relevant copyrights.
You may use the SOFTWARE on a single computer.

You may make one copy of the SOFTWARE in machine-readable
form for backup purposes only, if the SOFTWARE is on media where
such backup copy is permitted. On the backup copy, you must
reproduce Yamaha'’s copyright notice and any other proprietary
legends that were on the original copy of the SOFTWARE.

You may permanently transfer to a third party all your rights in the
SOFTWARE only when you transfer this product together, provided
that you do not retain any copies and the recipient reads and agrees
to the terms of this Agreement.

2. RESTRICTIONS

You may not engage in reverse engineering, disassembly,
decompilation or otherwise deriving a source code form of the
SOFTWARE by any method whatsoever.

You may not reproduce, modify, change, rent, lease, or distribute
the SOFTWARE in whole or in part, or create derivative works of the
SOFTWARE.

You may not electronically transmit the SOFTWARE from one
computer to another or share the SOFTWARE in a network with other
computers.

You may not use the SOFTWARE to distribute illegal data or data
that violates public policy.

You may not initiate services based on the use of the SOFTWARE
without permission by Yamaha Corporation.

Copyrighted data, including but not limited to MIDI data for songs,
obtained by means of the SOFTWARE, are subject to the following
restrictions which you must observe.

Data received by means of the SOFTWARE may not be used for any
commercial purposes without permission of the copyright owner.
Data received by means of the SOFTWARE may not be duplicated,
transferred, or distributed, or played back or performed for listeners
in public without permission of the copyright owner.

The encryption of data received by means of the SOFTWARE may
not be removed nor may the electronic watermark be modified
without permission of the copyright owner.

3. TERMINATION

This Agreement becomes effective on the day that you receive the
SOFTWARE and remains effective until terminated. If any copyright
law or provisions of this Agreement is violated, the Agreement shall
terminate automatically and immediately without notice from
Yamaha. Upon such termination, you must immediately destroy the
licensed SOFTWARE, any accompanying written documents and all
copies thereof.

4. LIMITED WARRANTY ON MEDIA
As to SOFTWARE sold on tangible media, Yamaha warrants that the
tangible media on which the SOFTWARE is recorded will be free from

defects in materials and workmanship under normal use for a period
of fourteen (14) days from the date of receipt, as evidenced by a
copy of the receipt. Yamaha's entire liability and your exclusive
remedy will be replacement of the defective media if it is returned to
Yamaha or an authorized Yamaha dealer within fourteen days with a
copy of the receipt. Yamaha is not responsible for replacing media
damaged by accident, abuse or misapplication. TO THE FULLEST
EXTENT PERMITTED BY LAW, YAMAHA EXPRESSLY DISCLAIMS
ANY IMPLIED WARRANTIES ON THE TANGIBLE MEDIA,
INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE.

5. DISCLAIMER OF WARRANTY ON SOFTWARE

You expressly acknowledge and agree that use of the SOFTWARE is
at your sole risk. The SOFTWARE and related documentation are
provided “AS IS” and without warranty of any kind.
NOTWITHSTANDING ANY OTHER PROVISION OF THIS
AGREEMENT, YAMAHA EXPRESSLY DISCLAIMS ALL WARRANTIES
AS TO THE SOFTWARE, EXPRESS, AND IMPLIED, INCLUDING BUT
NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NON-INFRINGEMENT OF THIRD PARTY RIGHTS. SPECIFICALLY,
BUT WITHOUT LIMITING THE FOREGOING, YAMAHA DOES NOT
WARRANT THAT THE SOFTWARE WILL MEET YOUR
REQUIREMENTS, THAT THE OPERATION OF THE SOFTWARE WILL
BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE
SOFTWARE WILL BE CORRECTED.

6. LIMITATION OF LIABILITY

YAMAHA'S ENTIRE OBLIGATION HEREUNDER SHALL BE TO
PERMIT USE OF THE SOFTWARE UNDER THE TERMS HEREOF. IN
NO EVENT SHALL YAMAHA BE LIABLE TO YOU OR ANY OTHER
PERSON FOR ANY DAMAGES, INCLUDING, WITHOUT LIMITATION,
ANY DIRECT, INDIRECT, INCIDENTAL OR CONSEQUENTIAL
DAMAGES, EXPENSES, LOST PROFITS, LOST DATA OR OTHER
DAMAGES ARISING OUT OF THE USE, MISUSE OR INABILITY TO
USE THE SOFTWARE, EVEN IF YAMAHA OR AN AUTHORIZED
DEALER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. In no event shall Yamaha's total liability to you for all
damages, losses and causes of action (whether in contract, tort or
otherwise) exceed the amount paid for the SOFTWARE.

7. GENERAL

This Agreement shall be interpreted according to and governed by
Japanese law without reference to principles of conflict of laws. Any
dispute or procedure shall be heard before the Tokyo District Court in
Japan. If for any reason a court of competent jurisdiction finds any
portion of this Agreement to be unenforceable, the remainder of this
Agreement shall continue in full force and effect.

8. COMPLETE AGREEMENT

This Agreement constitutes the entire agreement between the parties
with respect to use of the SOFTWARE and any accompanying written
materials and supersedes all prior or contemporaneous
understandings or agreements, written or oral, regarding the subject
matter of this Agreement. No amendment or revision of this
Agreement will be binding unless in writing and signed by a fully
authorized representative of Yamaha.
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FCC INFORMATION (U.S.A.)

1. IMPORTANT NOTICE: DO NOT MODIFY THIS
UNIT!
This product, when installed as indicated in the instructions
contained in this manual, meets FCC requirements. Modifi-
cations not expressly approved by Yamaha may void your
authority, granted by the FCC, to use the product.

2. IMPORTANT: When connecting this product to accesso-
ries and/or another product use only high quality shielded
cables. Cable/s supplied with this product MUST be used.
Follow all installation instructions. Failure to follow instruc-
tions could void your FCC authorization to use this product in
the USA.

3. NOTE: This product has been tested and found to comply
with the requirements listed in FCC Regulations, Part 15 for
Class “B” digital devices. Compliance with these require-
ments provides a reasonable level of assurance that your
use of this product in a residential environment will not result
in harmful interference with other electronic devices. This
equipment generates/uses radio frequencies and, if not
installed and used according to the instructions found in the
users manual, may cause interference harmful to the opera-

tion of other electronic devices. Compliance with FCC regu-
lations does not guarantee that interference will not occur in
all installations. If this product is found to be the source of
interference, which can be determined by turning the unit
“OFF” and “ON”, please try to eliminate the problem by using
one of the following measures:

Relocate either this product or the device that is being
affected by the interference.

Utilize power outlets that are on different branch (circuit
breaker or fuse) circuits or install AC line filter/s.

In the case of radio or TV interference, relocate/reorient the
antenna. If the antenna lead-in is 300 ohm ribbon lead,
change the lead-in to co-axial type cable.

If these corrective measures do not produce satisfactory
results, please contact the local retailer authorized to distrib-
ute this type of product. If you can not locate the appropriate
retailer, please contact Yamaha Corporation of America,
Electronic Service Division, 6600 Orangethorpe Ave, Buena
Park, CA90620

The above statements apply ONLY to those products distrib-
uted by Yamaha Corporation of America or its subsidiaries.

* This applies only to products distributed by YAMAHA CORPORATION OF AMERICA.

(class B)

COMPLIANCE INFORMATION STATEMENT
(DECLARATION OF CONFORMITY PROCEDURE)

Responsible Party : Yamaha Corporation of America
Address : 6600 Orangethorpe Ave., Buena Park,
Calif. 90620

Telephone : 714-522-9011
Type of Equipment : Music Synthesizer
Model Name : S90 XS, S70 XS

This device complies with Part 15 of the FCC Rules.

Operation is subject to the following two conditions:

1) this device may not cause harmful interference, and

2) this device must accept any interference received including
interference that may cause undesired operation.

See user manual instructions if interference to radio reception

is suspected.

* This applies only to products distributed by
YAMAHA CORPORATION OF AMERICA.

(FCC DoC)
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IMPORTANT NOTICE FOR THE UNITED KINGDOM
Connecting the Plug and Cord

WARNING: THIS APPARATUS MUST BE EARTHED IMPOR-
TANT. The wires in this mains lead are coloured in accor-
dance with the following code:

GREEN-AND-YELLOW EARTH
BLUE : NEUTRAL
BROWN : LIVE

As the colours of the wires in the mains lead of this apparatus
may not correspond with the coloured markings identifying the
terminals in your plug proceed as follows:

The wire which is coloured GREEN-and-YELLOW must be
connected to the terminal in the plug which is marked by the
letter E or by the safety earth symbol @ or colored GREEN or
GREEN-and-YELLOW.

The wire which is coloured BLUE must be connected to the
terminal which is marked with the letter N or coloured
BLACK.

The wire which is coloured BROWN must be connected to the
terminal which is marked with the letter L or coloured RED.

« This applies only to products distributed by Yamaha Music U.K. Ltd.

(3 wires)




For details of products, please contact your nearest Yamaha
representative or the authorized distributor listed below.

Pour plus de détails sur les produits, veuillez-vous adresser a2 Yamaha ou
au distributeur le plus proche de vous figurant dans la liste suivante.

Die Einzelheiten zu Produkten sind bei Ihrer unten aufgefiihrten
Niederlassung und bei Yamaha Vertragshidndlern in den jeweiligen
Bestimmungslidndern erhiltlich.

Para detalles sobre productos, contacte su tienda Yamaha mads cer-

cana o el distribuidor autorizado que se lista debajo.

| NORTH AMERICA |

CANADA
Yamaha Canada Music Ltd.
135 Milner Avenue, Scarborough, Ontario,
MIS 3R1, Canada
Tel: 416-298-1311

US.A.
Yamaha Corporation of America
6600 Orangethorpe Ave., Buena Park, Calif. 90620,
US.A.
Tel: 714-522-9011

| CENTRAL & SOUTH AMERICA |

MEXICO
Yamaha de México S.A. de C.V.
Calz. Javier Rojo Gémez #1149,
Col. Guadalupe del Moral
C.P. 09300, México, D.E., México
Tel: 55-5804-0600

BRAZIL
Yamaha Musical do Brasil Ltda.
Rua Joaquim Floriano, 913 - 4' andar, Itaim Bibi,
CEP 04534-013 Sao Paulo, SP. BRAZIL
Tel: 011-3704-1377

ARGENTINA
Yamaha Music Latin America, S.A.
Sucursal de Argentina
Olga Cossettini 1553, Piso 4 Norte
Madero Este-C1107CEK
Buenos Aires, Argentina
Tel: 011-4119-7000

PANAMA AND OTHER LATIN
AMERICAN COUNTRIES/
CARIBBEAN COUNTRIES
Yamaha Music Latin America, S.A.
Torre Banco General, Piso 7, Urbanizacién Marbella,
Calle 47 y Aquilino de la Guardia,
Ciudad de Panam4, Panama
Tel: +507-269-5311

| EUROPE |

THE UNITED KINGDOM/IRELAND
Yamaha Music UK. Ltd.
Sherbourne Drive, Tilbrook, Milton Keynes,
MK?7 8BL, England
Tel: 01908-366700

GERMANY
Yamaha Music Europe GmbH
Siemensstrafle 22-34, 25462 Rellingen, Germany
Tel: 04101-3030

SWITZERLAND/LIECHTENSTEIN
Yamaha Music Europe GmbH
Branch Switzerland in Ziirich
Seefeldstrasse 94, 8008 Ziirich, Switzerland
Tel: 01-383 3990

AUSTRIA
Yamaha Music Europe GmbH Branch Austria
Schleiergasse 20, A-1100 Wien, Austria
Tel: 01-60203900
CZECH REPUBLIC/SLOVAKIA/
HUNGARY/SLOVENIA
Yamaha Music Europe GmbH Branch Austria
Schleiergasse 20, A-1100 Wien, Austria
Tel: 01-602039025
POLAND/LITHUANIA/LATVIA/ESTONIA
Yamaha Music Europe GmbH
Branch Sp.z o.0. Oddzial w Polsce
ul. 17 Stycznia 56, PL-02-146 Warszawa, Poland
Tel: 022-868-07-57

THE NETHERLANDS/
BELGIUM/LUXEMBOURG
Yamaha Music Europe Branch Benelux
Clarissenhof 5-b, 4133 AB Vianen, The Netherlands
Tel: 0347-358 040

FRANCE
Yamaha Musique France
BP 70-77312 Marne-la-Vallée Cedex 2, France
Tel: 01-64-61-4000

ITALY
Yamaha Musica Italia S.P.A.
Combo Division
Viale Italia 88, 20020 Lainate (Milano), Italy
Tel: 02-935-771

SPAIN/PORTUGAL
Yamaha Musica Ibérica, S.A.
Ctra. de la Coruna km. 17, 200, 28230
Las Rozas (Madrid), Spain
Tel: 91-639-8888

GREECE
Philippos Nakas S.A. The Music House
147 Skiathou Street, 112-55 Athens, Greece
Tel: 01-228 2160

SWEDEN
Yamaha Scandinavia AB
J. A. Wettergrens Gata 1, Box 30053
S-400 43 Goteborg, Sweden
Tel: 031 89 34 00

DENMARK
YS Copenhagen Liaison Office
Generatorvej 6A, DK-2730 Herlev, Denmark
Tel: 44 92 49 00

FINLAND
F-Musiikki Oy
Kluuvikatu 6, P.O. Box 260,
SF-00101 Helsinki, Finland
Tel: 09 618511

NORWAY

Norsk filial av Yamaha Scandinavia AB
Grini Neringspark 1, N-1345 @sterds, Norway
Tel: 67 16 77 70

ICELAND
Skifan HF
Skeifan 17 P.O. Box 8120, IS-128 Reykjavik, Iceland
Tel: 525 5000

RUSSIA
Yamaha Music (Russia)
Office 4015, entrance 2, 21/5 Kuznetskii
Most street, Moscow, 107996, Russia
Tel: 495 626 0660

OTHER EUROPEAN COUNTRIES
Yamaha Music Europe GmbH

Siemensstrae 22-34, 25462 Rellingen, Germany
Tel: +49-4101-3030

AFRICA |

Yamaha Corporation,

Asia-Pacific Music Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu,
Japan 430-8650

Tel: +81-53-460-2312

| MIDDLE EAST |

TURKEY/CYPRUS
Yamaha Music Europe GmbH
Siemensstrafle 22-34, 25462 Rellingen, Germany
Tel: 04101-3030

OTHER COUNTRIES
Yamaha Music Gulf FZE
LOB 16-513, P.O.Box 17328, Jubel Ali,

Dubai, United Arab Emirates
Tel: +971-4-881-5868

| ASIA

THE PEOPLE’S REPUBLIC OF CHINA
Yamaha Music & Electronics (China) Co.,Ltd.
2F, Yunhedasha, 1818 Xinzha-lu, Jingan-qu,
Shanghai, China
Tel: 021-6247-2211

HONG KONG
Tom Lee Music Co., Ltd.

11/F., Silvercord Tower 1, 30 Canton Road,
Tsimshatsui, Kowloon, Hong Kong
Tel: 2737-7688

INDIA
Yamaha Music India Pvt. Ltd.
SF Ambience Corporate Tower Ambience Mall Complex
Ambience Island, NH-8, Gurgaon-122001, Haryana, India
Tel: 0124-466-5551

INDONESIA
PT. Yamaha Music Indonesia (Distributor)
PT. Nusantik
Gedung Yamaha Music Center, Jalan Jend. Gatot
Subroto Kav. 4, Jakarta 12930, Indonesia
Tel: 21-520-2577

KOREA
Yamaha Music Korea Ltd.
8F, 9F, Dongsung Bldg. 158-9 Samsung-Dong,
Kangnam-Gu, Seoul, Korea
Tel: 080-004-0022

MALAYSIA
Yamaha Music Malaysia, Sdn., Bhd.
Lot 8, Jalan Perbandaran, 47301 Kelana Jaya,
Petaling Jaya, Selangor, Malaysia
Tel: 3-78030900
PHILIPPINES
Yupangco Music Corporation
339 Gil J. Puyat Avenue, P.O. Box 885 MCPO,
Makati, Metro Manila, Philippines
Tel: 819-7551

SINGAPORE
Yamaha Music Asia Pte., Ltd.
#03-11 A-Z Building
140 Paya Lebor Road, Singapore 409015
Tel: 747-4374

TAIWAN
Yamaha KHS Music Co., Ltd.
3F, #6, Sec.2, Nan Jing E. Rd. Taipei.
Taiwan 104, R.O.C.
Tel: 02-2511-8688

THAILAND
Siam Music Yamaha Co., Ltd.
4,6, 15 and 161 floor, Siam Motors Building,
891/1 Rama 1 Road, Wangmai,
Pathumwan, Bangkok 10330, Thailand
Tel: 02-215-2626

OTHER ASIAN COUNTRIES
Yamaha Corporation,
Asia-Pacific Music Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu,
Japan 430-8650
Tel: +81-53-460-2317

| OCEANIA

AUSTRALIA
Yamaha Music Australia Pty. Ltd.
Level 1, 99 Queensbridge Street, Southbank,
Victoria 3006, Australia
Tel: 3-9693-5111

NEW ZEALAND
Music Works LTD
P.O.BOX 6246 Wellesley, Auckland 4680,
New Zealand
Tel: 9-634-0099

COUNTRIES AND TRUST
TERRITORIES IN PACIFIC OCEAN
Yamaha Corporation,
Asia-Pacific Music Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu,
Japan 430-8650
Tel: +81-53-460-2312

SY51

HEAD OFFICE

Yamaha Corporation, Pro Audio & Digital Musical Instrument Division

Nakazawa-cho 10-1, Naka-ku, Hamamatsu, Japan 430-8650

Tel: +81-53-460-2432
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